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1.1 Introduction

spColumn is a software program for the design and investigation of reinforced concrete sections
subject to axial and flexural loads. The section can be rectangular, round or irregular, with any
reinforcement layout or pattern. Slenderness effects can be considered.

The program offers investigation of irregularly shaped, reinforced concrete column sections that
may contain openings or boundary elements. Widely used for design of shear walls, bridge piers
as well as typical framing elements in buildings, spColumn can investigate sections that are
impossible to find on design charts or do by hand calculations. You can obtain the P-M interaction
diagrams from both uniaxial and biaxial runs, as well as the Mx-My moment contour plots from
biaxial runs for even the most irregular column and shear wall sections. Slenderness effects
producing magnified moments may be included in the investigation.

1.2 Program Features

• Code support for ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, ACI 318-02

• Code support for CSA A23.3-14, CSA A23.3-04, and CSA A23.3-94

• English and SI units

• Design and investigation run options

• Uniaxial or biaxial flexure combined with axial load

• Rectangular, circular, and irregular section geometry

• Non-slender and sway or nonsway slender columns

• Complete P-M and Mx-My interaction diagrams

• Customizable view of interaction diagrams

• Superposition of interaction diagram from a different run

• Factored, unfactored, axial, and control points loading

• Binary (COL) and text (CTI) input file formats

• Graphical input for irregular sections

• Imports geometry, reinforcement, and loads from text files

• Imports section shape and reinforcement from DXF files

• Exports section shape and reinforcement to DXF files
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• spSection module for creating and modifying irregular sections

• spResults module for viewing and exporting input and output data

• spReporter module for generating , viewing, exporting and printing results

• Exports graphical reports (screen printouts) to EMF files

• Exports P-M diagrams, Mx-My diagrams, and 3D failure surface to TXT and CSV files

• GUI (Graphical User Interface) and batch mode (command prompt) runs

• Reports neutral axis location and maximum steel strain corresponding to section capacity

• Reports neutral axis location, net tensile steel strain, and strength reduction factors in text 
output

1.3 Program Capacity

• 10,000 reinforcing bars within a section.

• 10,000 exterior points that define the geometric outline of the cross section (spSection 
module).

• 10,000 interior points that define an opening in the cross section (spSection module).

• 10,000 factored load entries, each consisting of an axial load, a moment about the x-axis, 
and a moment about the y-axis.

• 50 service load entries, each consisting of dead, live, wind, earthquake, and snow axial 
loads, moments at column top about the x and y axes, and moments at column bottom 
about the x and y axes.

• 50 load combinations.

1.4 System Requirements

Any computer running Microsoft Windows Vista SP2, Windows 7, Windows 8, or Windows 10
operating system with 32 or 64 bit processing is sufficient to run the spColumn program. For
instructions on how to troubleshoot system specific installation and licensing issues, please refer
to support pages on StructurePoint website at www.StructurePoint.org.

https://www.structurepoint.org/
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1.5 Terms

The following terms are used throughout this manual. A brief explanation is given to help
familiarize you with them.

1.6 Conventions

To help you locate and interpret information easily, the spColumn manual adheres to the following
text format.

Windows refers to the Microsoft Windows environment as listed in System
Requirements.

[ ] indicates metric equivalent

Click on means to position the cursor on top of a designated item or location
and press and release the left-mouse button (unless instructed to use
the right-mouse button).

Double-click on means to position the cursor on top of a designated item or location
and press and release the left-mouse button twice in quick
succession.

Italic indicates a glossary item, or emphasizes a given word or phrase.

Bold indicates the name of a menu or a menu item command such as File
or Save.

Mono-space indicates something you should enter with the keyboard. For
example “c:\*.txt”.

KEY + KEY indicates a key combination. The plus sign indicates that you should
press and hold the first key while pressing the second key, then
release both keys. For example, “ALT + F” indicates that you should
press the “ALT” key and hold it while you press the “F” key. then
release both keys.

SMALL CAPS Indicates the name of an object such as a dialog box or a dialog box
component. For example, the OPEN dialog box or the CANCEL or
MODIFY buttons.
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1.7 Installing, Purchasing and Licensing spColumn

For instructions on how to install, purchase, and license StructurePoint software please refer to
support pages on StructurePoint website at www.StructurePoint.org.

https://www.structurepoint.org/
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2.1 Definitions and Assumptions

1. The analysis of the reinforced concrete section performed by spColumn conforms to the

provisions of the Strength Design Method1 and Unified Design Provisions2 and is based
on the following assumptions. 

a) All conditions of strength satisfy the applicable conditions of equilibrium and strain 

compatibility3

b) Strain in the concrete and in the reinforcement is directly proportional to the distance

from the neutral axis4. In other words, plane sections normal to the axis of bending are
assumed to remain plane after bending. 

c) The maximum usable (ultimate) strain at the extreme concrete compression fiber is

assumed equal to 0.003 for ACI codes5 and 0.0035 for CSA codes6 unless otherwise
specified by the user

d) A uniform rectangular concrete stress block is used. For ACI code7, the maximum
uniform concrete compressive stress, fc, is 0.85fc' by default and the block depth is

β1c, where c is the distance from the extreme compression fiber to the neutral axis and

β1 is described in item 4 below. For CSA8, fc is taken as:

fc = (0.85 − 0.0015fc')fc' ≥ 0.68fc', where fc' is in MPa

Both fc and β1 can be modified by the user.

e) Concrete displaced by the reinforcement in compression is deducted from the

compression block9 

1.  For CSA A23.3-04 (Ref. [6]) and CSA A23.3-94 (Ref.[7])
2.  For ACI 318-14 (Ref. [1]), ACI 318-11 (Ref. [1]), ACI 318-08 (Ref. [2]), ACI 318-05 (Ref. [3]) and ACI

318-02 (Ref. [4]); also see notes on ACI 318-08, 8.1.2 in Ref. [9] and notes on ACI 318-11, 8.1.2 in Ref.
[13]

3.  ACI 318-14, 4.5.1, 22.2.1.1, 13.2.6.2; ACI 318-11, 10.2.1; ACI 318-08, 10.2.1; ACI 318-05, 10.2.1; ACI
318-02, 10.2.1; CSA A23.3-14, 10.1.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1

4. ACI 318-14, 22.1.2, 22.2.1.2; ACI 318-11, 10.2.2; ACI 318-08, 10.2.2; ACI 318-05, 10.2.2; ACI 318-02,
10.2.2; CSA A23.3-14, 10.1.2; CSA A23.3-04, 10.1.2; CSA A23.3-94, 10.1.2

5. ACI 318-14, 22.2.2.1; ACI 318-11, 10.2.3; ACI 318-08, 10.2.3; ACI 318-05, 10.2.3; ACI 318-02, 10.2.3
6. CSA A23.3-14, 10.1.3; CSA A23.3-04, 10.1.3; CSA A23.3-94, 10.1.3
7. ACI 318-14, 22.2.2.3; ACI 318-11, 10.2.6; ACI 318-08, 10.2.6, 10.2.7; ACI 318-05, 10.2.6, 10.2.7; ACI

318-02, 10.2.6, 10.2.6
8. CSA A23.3-14, 10.1.1; CSA A23.3-04, 10.1.1; CSA A23.3-94, 10.1.1
9.  For consistency with Eq. 10-1 and 10-2 in ACI codes (Refs. [1], [3], [4]) and with Eq. 10-10 in CSA

codes (Refs. [6], [7])
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f) For the reinforcing steel, the elastic-plastic stress-strain distribution is used10. Stress in
the reinforcing steel below the yield strength, fy, is directly proportional to the strain.

For strains greater than that corresponding to the yield strength, the reinforcement
stress remains constant and equal to fy. Reinforcing steel yield strength must be within

customary ranges.

g) Tensile strength of concrete in axial and flexural calculations is neglected11.

h) Reinforcement bars are located within section outline.

i) Irregular sections must be composed of a closed polygon without any intersecting
sides.

j) Members with very large cross sectional area, multiple openings, and unusual
geometry must be carefully evaluated in light of above assumption for solution
stability and reliability of results.

2. The modulus of elasticity of concrete, Ec is computed as follows (unless otherwise

specified by the user):

Ec = 57,000 , for the ACI code12 where  and Ec are in psi,

Ec = 4,700 , for the ACI code13 where  and Ec are in MPa.

For the CSA standard14, Ec = 3,518 +7,355, where  and Ec are in MPa.

3. The modulus of elasticity of reinforcing steel15, Es, is taken as 29,000 ksi (200,000 MPa)

unless otherwise specified by the user. The computed compression controlled strain limit
cannot exceed 0.005 and is reset to 0.002 for user input fy values in excess of 145 ksi.

10. ACI 318-14, 20.2.2.1; ACI 318-11, 10.2.4; ACI 318-08, 10.2.4; ACI 318-05, 10.2.4; ACI 318-02,
10.2.4; CSA A23.3-14, 8.5.3.2; CSA A23.3-04, 8.5.3.2; CSA A23.3-94, 8.5.3.2

11.ACI 318-14, 22.2.2.2; ACI 318-11, 10.2.5; ACI 318-08, 10.2.5; ACI 318-05, 10.2.5; ACI 318-02, 10.2.5;
CSA A23.3-14, 10.1.5; CSA A23.3-04, 10.1.5; CSA A23.3-94, 10.1.5

12.ACI 318-14, 19.2.2.1; ACI 318-11, 8.5.1; ACI 318-08, 8.5.1; ACI 318-05, 8.5.1; ACI 318-02, 8.5.1
13. ACI 318M-14, 19.2.2.1; ACI 318M-11, 8.5.1; ACI 318M-08, 8.5.1; ACI 318M-05, 8.5.1; ACI 318M-02,

8.5.1
14. CSA A23.3-14, 8.6.2.2, Eq. 8.1, CSA A23.3-04, 8.6.2.2, Eq. 8.1 and CSA A23.3-94, 8.6.2.3, Eq. 8-6

(with c = 2400 kg/m3)

15. ACI 318-14, 20.2.2.2; ACI 318-11, 8.5.2; ACI 318-08, 8.5.2; ACI 318-05, 8.5.2; ACI 318-02, 8.5.2; ACI
318M-05, 8.5.2; ACI 318M-02, 8.5.2; CSA A23.3-14, 8.5.4.1; CSA A23.3-04, 8.5.4.1; CSA A23.3-94,
8.5.4.1

fc
′ f ′c

fc
′ f ′c

fc
′ f ′c
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Figure 2-1 Analysis of Reinforced Section

4. The ratio of the concrete compression block depth to the distance between the extreme
compression fiber and the neutral axis, β1, is computed as follows (unless otherwise

specified by the user):

, for the ACI code16 where  is in ksi,

, for the ACI code17 where  is in MPa.

For the CSA standard18, , where  is in MPa.

5. Stress in the reinforcement is computed based on the strain at the centroid of each
reinforcing bar.

6. All moments are referenced to the geometric centroid of the gross concrete section
(neglecting the reinforcement).

16. ACI 318-14, 22.2.2.4.3; ACI 318-11, 10.2.7.3; ACI 318-08, 10.2.7.3; ACI 318-05, 10.2.7.3; ACI 318-
02, 10.2.7.3

17. ACI 318M-14, 22.2.2.4.3; ACI 318M-11, 10.2.7.3; ACI 318M-08, 10.2.7.3; ACI 318M-05, 10.2.7.3;
ACI 318M-02, 10.2.7.3

18. CSA A23.3-14, 10.1.7(c); CSA A23.3-04, 10.1.7(c); CSA A23.3-94, 10.1.7(c) 
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7. For the ACI codes, the nominal (unreduced) capacity of the section is first computed.
Then, the nominal capacity is reduced to the design capacity using the strength reduction
factor, ϕ, the value of which is calculated based on the net tensile steel strain, εt,in the

following way19.

• For columns with spiral reinforcement per ACI 318-14, ACI 318-11, and ACI 318-08

• For columns with spiral reinforcement per ACI 318-05 and ACI 318-02

• For other columns per ACI 318-14, ACI 318-11, ACI 318-08, ACI 318-05, and ACI 
318-02

19.ACI 318-14, 21.2; ACI 318-11, 9.3.2, 10.3.3, 10.3.4; ACI 318-08, 9.3.2, 10.3.3, 10.3.4; ACI 318-05,
9.3.2, 10.3.3, 10.3.4; ACI 318-02, 9.3.2, 10.3.3, 10.3.4

( )
ϕ

if ε tension controlled tion

if f E ε transition tion

if ε f E compression controlled tion

0.9 0.005 ( sec )

0.75 / 0.005 ( sec )

0.75 / ( sec )

t

ε f E

f E y y t

t y y

0.15 /

0.005 /

t y s

y s
















  







( )
ϕ

if ε tension controlled tion

if f E ε transition tion

if ε f E compression controlled tion

0.9 0.005 ( sec )

0.70 / 0.005 ( sec )

0.70 / ( sec )

t

ε f E

f E y y t

t y y

0.20 /

0.005 /

t y s

y s
















  







( )
ϕ

if ε tension controlled tion

if f E ε transition tion

if ε f E compression controlled tion

0.9 0.005 ( sec )

0.65 / 0.005 ( sec )

0.65 / ( sec )

t

ε f E

f E y y t

t y y

0.25 /

0.005 /

t y s

y s
















  









METHOD OF SOLUTION

| 20 |

Figure 2-2 Reduction factors for Flexural and Axial Capacity per ACI Code

Figure 2-2 illustrates variation of the strength reduction factor with net tensile strain in extreme
tension steel and the impact of the strength reduction factor on the axial and flexural capacity
interaction diagram. It is worth noting that in the transition between compression controlled and
tension controlled zones, the nominal axial capacity, Pn, decreases whereas the value of net tensile

strain increases and so does the strength reduction factor, ϕ. Consequently, the resulting factored
axial capacity (i.e. the product of nominal axial capacity and the strength reduction factor), ϕPn,

may either increase or decrease in the transition zone depending on the rates of axial force
decrease and strength reduction increase for the section under consideration. Typically, the rate of
axial capacity decrease dominates over the rate of strength reduction increase and thus the factored
axial load capacity decreases as well. 

For certain classes of sections (e.g. sections having a narrowing in the middle such as hollow core
section, T-shaped, L-shaped, and I-shaped sections), however, the reverse may be true resulting in
the factored axial load capacity increase in the transition zone between compression controlled
and tension controlled zones. This unusual increase in axial load capacity is not illustrated by
interaction diagrams produced by the program and is not considered for design and investigation
of cross-sections. It will be flagged to inform the user, however, when the program is run using
Control Points as the load type.

Where unsymmetrical members (e.g. C-shaped or U-shaped sections) are investigated under
biaxial bending, the Mx-My contour diagram occasionally crosses the X or Y axes more than
once. This presents an unusual situation where a load point may exist outside of the Mx-My

Spiral*

Other

fy

Es

0.90

0.75 or 0.70

0.65

0.005

Compression
controlled Transition

Tension
Controlled

Moment, M

Tension
controlled

Transition

Factored (Design)
Interaction Diagram

Nominal Interaction Diagram

Axial

Load,
P

ϕPn,

ϕPn,max

Max.
Tension

ϕ

*Spiral sections in compression controlled zone: ϕ = 0.75 per ACI 318-14/11/08 and ϕ = 0.70 per ACI 318-05/02

Max.
Compression

Pn,

Maximum Design
Axial Load

Balanced failure and
compression-controlled

limit

Tension-controlled limit

Pure Bending

Te
ns

io
n

C
om

pr
es

si
on

Compression
controlled



METHOD OF SOLUTION

| 21 |

contour while appearing within the P-Mx or P-My contour views. It is suggested the Mx-My
contours be investigated carefully for each factored axial load level.

For the CSA standards, the program calculates the factored resistance directly using the factored

compressive concrete strength20, , and the factored forces in reinforcement bars21, . The

material resistance factors are:

ϕc  = 0.60 for CSA A23.3-94

 = 0.65 for CSA A23.3-04/14 (cast-in-place)

 = 0.70 for CSA A23.3-04/14 (precast) 

ϕs  = 0.85 for CSA A23.3-94/04/14

For all ACI and CSA A23.3-94/04 standards, the design axial capacity is capped22 at 0.85 of the
maximum axial capacity for sections with spiral reinforcement or at 0.80 for sections with tie
reinforcement. 

Additionally, for CSA A23.3-14 the design axial capacity is capped23 at 0.90 of the maximum
axial capacity for sections with spiral reinforcement or at (0.2+0.002h) ≤ 0.80 for sections with tie
reinforcement where h is the wall thickness or the minimum column dimension.

20. CSA A23.3-14, 8.4.2, 16.1.3; CSA A23.3-04, 8.4.2, 16.1.3; CSA A23.3-94, 8.4.2
21. CSA A23.3-14, 8.4.3; CSA A23.3-04, 8.4.3; CSA A23.3-94, 8.4.3
22. ACI 318-14, 22.4.2.1; ACI 318-11, 10.3.6; ACI 318-08, 10.3.6; ACI 318-05, 10.3.6; ACI 318-02,

10.3.6; CSA A23.3-14, 10.10.4; CSA A23.3-04, 10.10.4; CSA A23.3-94, 10.10.4 
23. CSA A23.3-14, 10.10.4

ϕ fc
′
c ϕ Ss i
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Figure 2-3 Shapes of P-M interaction diagram for ACI code and CSA standard

8. In the investigation mode the program will calculate capacity for any provided area of

reinforcement. However, if the reinforcement area falls below the code-specified24

minimum of 0.01 times the gross area, Ag, then two options, Architectural or Structural,

are available.

24. ACI 318-14, 10.6.1.1; ACI 318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02,
10.9.1; CSA A23.3-14, 10.9.1; CSA A23.3-04, 10.9.1; CSA A23.3-94, 10.9.1
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By default Architectural option is selected for which the capacity of the section is reduced.
For the ACI codes, the reduction results from multiplying the maximum concrete stress,

, by the ratio of reinforcement area to 0.01Ag. This produces the same effect as

reducing the effective concrete area25 to achieve ratio of reinforcement area to gross

concrete area equal to 0.01. For the CSA standards26, the factored axial and flexural

resistances are multiplied by ratio  for the 04 edition and  for the

94 edition.

For Structural option, the section is treated “as is” without any reductions in capacity. This
option is provided for informational purposes only, since per all codes supported by
spColumn, capacity of compression members with reinforcement area less than 0.01Ag

has to be reduced and areas below 0.005Ag are not allowed.

9. Under the Design option, the reinforcement ratio cannot be less than 1.0% if Structural
column type is selected in design criteria and 0.5% in case of Architectural column type.
For Architectural type, the capacity of the designed column is reduced as described above.
Additionally, User Defined type is provided in the design criteria, which allows designs
with reinforcement ratios not less than 0.1%. No reduction in capacity is applied for User
Defined column type.

10. Maximum reinforcement ratio27 for Structural and Architectural options in both
Investigation and Design modes is 8%. For User Defined type in the Design mode the
maximum reinforcement ratio is set to 20%.

11. Reinforcement design strength for standard materials is limited to the value permitted for

design calculations28 by ACI to 80 ksi and CSA to 500 MPa.

2.2 Conventions

1. Positive axial forces are compressive and negative axial forces are tensile.

2. Looking in plan at the section with z-axis pointing outwards, the positive x-axis points to
the right and the positive y-axis points up. For this section, vectors of positive bending
moments have the same orientation as their corresponding axes x and y. Thus, a positive
bending moment about the x-axis, Mx, produces tension at the top face of the section and

25. ACI 318-14, 10.3.1.2; ACI 318-11, 10.8.4; ACI 318-08, 10.8.4; ACI 318-05, 10.8.4; ACI 318-02, 10.8.4
26. CSA A23.3-14, 10.10.5; CSA A23.3-04, 10.10.5; CSA A23.3-94, 10.10.5
27. ACI 318-14, 10.6.1.1; ACI 318-11, 10.9.1; ACI 318-08, 10.9.1; ACI 318-05, 10.9.1; ACI 318-02,

10.9.1; CSA A23.3-14, 10.9.2; CSA A23.3-04, 10.9.2; CSA A23.3-94, 10.9.2
28. ACI 318-14, Table 20.2.2.4a; CSA A23.3-14, 8.5.1

f ′c

( )ρ0.5 1 + / 0.01t ρ / 0.01t
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compression at the bottom face. A positive bending moment about the y-axis, My,

produces tension at the left face of the section and compression at the right face.

Figure 2-4 Positive axial force and bending moments (internal forces)

3. If service loads are input, moment loads at the upper (top) and lower (bottom) ends of the
column are needed. Top and bottom moment loads of opposite signs produce single
curvature bending. Top and bottom moment loads of the same sign produce double
curvature bending.

Positive moment loads at the upper end of the column coincide with positive bending
moments. However, at the lower end, positive moment loads produce effects opposite to
positive bending moments. Therefore, spColumn changes the sign of the service moment
at the lower end to convert it from a moment load to a bending moment.

Axial load is assumed to be constant so it is input only as for the upper end where positive
axial load coincides with positive axial force.

4. If factored loads are input, they are considered to be applied at a section pointing upwards
so that they have the same orientations as positive axial force and positive bending
moments.

Top

Bottom

My

Mx

z

y

x

P
My

Mx

y

x

P My

z

P

x
Mx

z

P

y

My Mx

Section A-A Section B-B

x

P P

y

z z

A

B

A
B

z

A A

B

B



METHOD OF SOLUTION

| 25 |

Figure 2-5 Positive moment loads (external forces)

5. The convention for the slenderness input of beam and column dimensions and their
orientation is presented in Figure 2-6. Beams above the columns are shown. Same
convention applies to beam below the column.

Figure 2-6 Slenderness Input Convention
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2.3 Section Investigation Mode

2.3.1 Loading Options

The computations performed when investigating a section depend on the selected load mode:

a) Factored loads – for the axial load of each load point, the moment capacity and the 
ratio of design-to-applied moment are computed. For a biaxial run, the computed Mx 

and My moment capacities are at the same angle as that produced by the applied Mx 

and My moments. In uniaxial case the program also reports the depth of neutral axis 

and maximum steel strain corresponding to the calculated moment capacity. For the 
ACI code, the value of strength reduction factor is also reported.

spColumn allows defining up to 50 load combinations. The user has full control over 
the combinations. The program contains predefined (built into the program) default 
primary load combinations for the supported codes. These default combinations are 
created when starting a new project. The default load combinations of the Dead (D), 
Live (L), Wind (W), Earthquake (E) and Snow (S) loads considered by the program 

are shown below. For the ACI 318-14, 11, 08, 05, and 02 codes29:

U1 = 1.4D

U2 = 1.2D + 1.6L + 0.5S

U3 = 1.2D +1.0L + 1.6S

U4 = 1.2D + 0.8W + 1.6S

U5 = 1.2D +1.0L + 1.6W + 0.5S

U6 = 0.9D + 1.6W

U7 = 1.2D – 0.8W + 1.6S

U8 = 1.2D +1.0L – 1.6W + 0.5S

U9 = 0.9D – 1.6W

U10 = 1.2D +1.0L +1.0E – 0.2S

U11 = 0.9D +1.0E

U12 = 1.2D +1.0L – 1.0E + 0.2S

U13 = 0.9D – 1.0E

For the CSA A23.3-94 code30:

29. ACI 318-14, 5.3; ACI 318-11, 9.2; ACI 318-08, 9.2; ACI 318-05, 9.2; ACI 318-02, 9.2; (assuming W
based on service-level wind load and E based on ultimate-level forces)

30. CSA A23.3-94, 8.3.2 (conservatively assuming storage and assembly occupancies)
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U1 = 1.25D

U2 = 1.25D + 1.5L

U3 = 1.25D + 1.5L + 1.5S

U4 = 1.25D + 1.05L + 1.05W

U5 = 1.25D + 1.05L + 1.05W + 1.05S

U6 = 1.25D + 1.5W

U7 = 0.85D + 1.5W

U8 = 1.0D +1.0L + 1.0E

U9 = 1.0D +1.0L + 1.0E + 1.0S

U10 = 1.0D + 1.0E

U11 = 1.25D + 1.05L – 1.05W

U12 = 1.25D + 1.05L – 1.05W + 1.05S

U13 = 1.25D – 1.5W

U14 = 0.85D – 1.5W

U15 = 1.0D + 1.0L – 1.0E

U16 = 1.0D + 1.0L – 1.0E + 1.0S

U17 = 1.0D – 1.0E

For the CSA A23.3-04 code31:

U1 = 1.4D

U2 = 1.25D + 1.5L

U3 = 1.25D + 1.5L + 0.5S

U4 = 1.25D + 1.5L + 0.4W

U5 = 1.25D + 1.5L – 0.4W

U6 = 0.9D + 1.5L

U7 = 0.9D + 1.5L + 0.5S

U8 = 0.9D + 1.5L + 0.4W

U9 = 0.9D + 1.5L – 0.4W

U10 = 1.25D + 1.5S

U11 = 1.25D + 0.5L + 1.5S

U12 = 1.25D + 0.4W + 1.5S

31. CSA A23.3-14, 8.3.2; CSA A23.3-14, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2.A; CSA
A23.3-04, 8.3.2; CSA A23.3-04, Annex C, Table C1; NBCC 2005 [8], Table 4.1.3.2
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U13 = 1.25D – 0.4W + 1.5S

U14 = 0.9D + 1.5S

U15 = 0.9D + 0.5L + 1.5S

U16 = 0.9D + 0.4W + 1.5S

U17 = 0.9D – 0.4W + 1.5S

U18 = 1.25D + 1.4W

U19 = 1.25D + 0.5L + 1.4W

U20 = 1.25D + 1.4W + 0.5S

U21 = 1.25D – 1.4W

U22 = 1.25D + 0.5L – 1.4W + 0.5S

U23 = 1.25D – 1.4W + 0.5S

U24 = 0.9D + 0.5L + 1.4W

U25 = 0.9D + 0.5L + 1.4W

U26 = 0.9D + 1.4W + 0.5S

U27 = 0.9D – 1.4W

U28 = 0.9D + 0.5L – 1.4W

U29 = 0.9D – 1.4W + 0.5S

U30 = 1.0D + 1.0E

U31 = 1.0D + 0.5L + 1.0E + 0.25S

U32 = 1.0D – 1.0E

U33 = 1.0D + 0.5L – 1.0E + 0.25S 

For the CSA A23.3-14 code32:

U1 = 1.4D

U2 = 1.25D + 1.5L

U3 = 1.25D + 1.5L + 1.0S

U4 = 1.25D + 1.5L + 0.4W

U5 = 1.25D + 1.5L – 0.4W

U6 = 0.9D + 1.5L

U7 = 0.9D + 1.5L + 1.0S

U8 = 0.9D + 1.5L + 0.4W

32. CSA A23.3-14 Annex C, Table C1; NBCC 2010 [8], Table 4.1.3.2A; CSA A23.3-04, Annex C, Table
C1; NBCC 2005 [8], Table 4.1.3.2
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U9 = 0.9D + 1.5L – 0.4W

U10 = 1.25D + 1.5S

U11 = 1.25D + 1.0L + 1.5S

U12 = 1.25D + 0.4W + 1.5S

U13 = 1.25D – 0.4W + 1.5S

U14 = 0.9D + 1.5S

U15 = 0.9D + 1.0L + 1.5S

U16 = 0.9D + 0.4W + 1.5S

U17 = 0.9D – 0.4W + 1.5S

U18 = 1.25D + 1.4W

U19 = 1.25D + 0.5L + 1.4W

U20 = 1.25D + 1.4W + 0.5S

U21 = 1.25D – 1.4W

U22 = 1.25D + 0.5L – 1.4W + 0.5S

U23 = 1.25D – 1.4W + 0.5S

U24 = 0.9D + 0.5L + 1.4W

U25 = 0.9D + 0.5L + 1.4W

U26 = 0.9D + 1.4W + 0.5S

U27 = 0.9D – 1.4W

U28 = 0.9D + 0.5L – 1.4W

U29 = 0.9D – 1.4W + 0.5S

U30 = 1.0D + 1.0E

U31 = 1.0D + 0.5L + 1.0E + 0.25S

U32 = 1.0D – 1.0E

U33 = 1.0D + 0.5L – 1.0E + 0.25S

b) Service loads – the program calculates the factored loads using the input load
combinations. If slenderness effects are to be checked and the column is found to be
slender, the applied moments are magnified according to Procedures 2.5 and 2.6. For
each calculated factored load, the same computations described in (a) above are
performed. 

c) Control points – for several key points on the interaction diagram, the program
calculates axial load and moment capacity together with the neutral axis depth and
maximum steel strain corresponding to the respective moment capacity. For ACI code,
strength reduction factor is also reported. The following key points are used by the
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program: maximum compression, allowable compression, point where steel stress is
zero, point where steel stress is 0.5fy, balanced point, pure flexure and maximum

tension. For ACI code, an additional control point is introduced where maximum steel
strain is equal to 0.005 (tension control limit).

d) Axial loads – for each input axial load, the program calculates the positive and
negative moment capacities together with the corresponding neutral axis depths and
maximum steel strains. For ACI code, strength reduction factors are also reported.

2.3.2 Interaction Diagram Options

The program also computes the interaction diagram (uniaxial runs) or the three-dimensional
failure surface (biaxial runs) of the input section. The values of maximum compressive axial load
capacity and maximum tensile load capacity are computed. These two values set the range within
which the moment capacities are computed for a predetermined number of axial load values.

a) For uniaxial runs, positive and negative moment capacities about only the selected 
axis are computed. Moment capacities about the orthogonal axis are ignored. To 
compute the moment capacity at a certain level of axial load, the neutral axis angle is 
held constant, parallel to the selected axis. The neutral axis depth is adjusted to arrive 
at the desired axial load capacity. This is done for all the predetermined values of axial 
load. 

b) For biaxial runs, the same predetermined values of axial load are utilized. For each
level of axial load, the section is rotated in 10-degree increments from 0 degrees to 360
degrees and the Mx and My moment capacities are computed. Thus for each level of

axial load, an Mx-My contour is developed. Repeating this for the entire range of axial

loads, the three-dimensional failure surface is computed. A three-dimensional
visualization of the resulting entire nominal and factored failure surface is provided to
support enhanced understanding of the section capacity. 

Also for each point on the interaction diagram or on the three-dimensional failure surface, the
program calculates the location of the neutral axis (expressed in terms of depth and angle of the
neutral axis), maximum steel strain, and (for ACI codes only) the strength reduction factor. These
results are reported for the maximum capacity of the section based on the ultimate limit states and
not for the given loading input. The information can however be used to draw conclusions or make
additional calculations for a given loading condition. 
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Figure 2-7 Interaction Surface for Combined Axial Load and Biaxial Bending

2.4 Section Design Mode

1. Based on the specified minimum, maximum and increment specified for the section and
the reinforcing bars, the program selects the smallest section with the least amount of
reinforcement for which the load-moment capacity exceeds the applied loads. If service
loads are input, they are factored using the input load combinations. Depending on the
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design criteria the user selects, the least amount of reinforcement the program searches for
means either the smallest number of bars or the smallest steel area.

2. The program starts the design by trying the smallest section (minimum dimensions) and
the least amount of reinforcing bars. The program verifies that the ratio of provided
reinforcement is always within the specified minimum and maximum ratios. Furthermore,

unless otherwise specified by the user33, the bar spacing is always kept greater than or

equal to the larger of 1.5 times the bar diameter or 1.5 in. [40 mm] for ACI34 and 1.4 times

the bar diameter or 1.2 in [30 mm] for CSA35.

3. A section fails the design if, for the design axial load, the ratio of design-to-applied
moment is less than 1.0 (unless otherwise specified in the Design Criteria dialog box). 

4. Once a section passes the design, its capacity is computed and the calculations explained
in Procedure 2.3 above are performed.

5. For members with large cross sectional area spColumn sometimes warns the user with the
following message “Cannot achieve desired accuracy”. This results when the program
cannot meet the predefined convergence criteria and the corresponding point on the
interaction diagram may be slightly off. The convergence criteria is more stringent than
required in engineering practice, however, the shape of the interaction diagram should be
verified to be relatively smooth and free of unexpected discontinuity.

2.5 Moment Magnification at Ends of Compression 
Member

This procedure accounts for moment magnification due to second-order effects at ends of columns

in sway frames36. 

1. If properties of framing members are input, spColumn computes the effective length

factor, ks, for sway condition using the following equation37: 

33. The user may select spacing greater than the default value to take into account tolerances for reinforce-
ment placement (see ACI 117-06, Ref [5]) and other project specific considerations.

34. ACI 318-14, 25.2.3; ACI 318-11, 7.6.3; ACI 318-08, 7.6.3; ACI 318-05, 7.6.3; ACI 318-02, 7.6.3
35. CSA A23.3-14, Annex A, 6.6.5.2; CSA A23.3-04, Annex A, 6.6.5.2; CSA A23.3-94, Annex A, A12.5.2
36. ACI 318-14, 6.6.4.6.1; ACI 318-11, 10.10.7; ACI 318-08, 10.10.7; ACI 318-05, 10.13; ACI 318-02,

10.13; CSA A23.3-14, 10.16; CSA A23.3-04, 10.16; CSA A23.3-94, 10.16
37. Exact formula derived in Ref. [12] pp. 851 for Jackson and Moreland alignment chart
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where ψ is the ratio of ∑(EI/ℓc) of columns to ∑(EI/ℓ) of beams in a plane at one end of

the column, ψA and ψB are the values of ψ at the upper end and the lower end of the

column. For a hinged end, ψ is very large. This happens in the case where ∑(EI/ℓ) of
beams is very small (or zero) relative to the ∑(EI/ℓc) of columns at that end. In this case,

the program outputs 999.9 for the value of ψ. The moment of inertia used in computing ψ

is the gross moment of inertia multiplied by the cracked section coefficients38 (specified
in the Slenderness Factors dialog box). 

2. For the ACI code39, slenderness effects will be considered if . For the CSA
standards, all sway columns are designed for slenderness effects.

3. If the ratio kℓu/r exceeds 100, slenderness effects cannot be accounted for using moment

magnification procedure40. A more exact method must be used. In this case, the program
issues a warning message and aborts design or investigation procedure except for

calculations per ACI 318-14, ACI 318-11, and ACI 318-08 where limit of 
does not explicitly apply and the program continues calculations after showing the
warning message.

4. Factored moments, Mns,top and Mns,bot, due to dead, live, and snow loads assumed to

cause no appreciable sidesway41, are calculated at the top and bottom ends of the column.

5. Factored moments, Ms,top and Ms,bot, due to lateral loads (wind and earthquake) assumed

to cause appreciable sidesway42, are calculated at the top and bottom ends of the column.

6. Flexural stiffness EI is calculated as43:

where Ec is the modulus of elasticity of concrete, Es is the modulus elasticity of steel, Ig is

the gross moment of inertia of the concrete section, Ise is the moment of inertia of

38. ACI 318-14, 6.6.3.1.1, 6.6.4.2, 6.7.1.3, 6.8.1.4; ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-
05, 10.11.1, 10.13.1; ACI 318-02, 10.11.1, 10.13.1; CSA A23.3-14, 10.14.1.2, 10.16.1; CSA A23.3-04,
10.14.1.2, 10.16.1; CSA A23.3-94, 10.14.1, 10.16.1

39. ACI 318-14, 6.2.5; ACI 318-11, 10.10.1; ACI 318-08, 10.10.1; ACI 318-05, 10.13.2; ACI 318-02,
10.13.2

40. ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-14, 10.13.2; CSA A23.3-04, 10.13.2; CSA
A23.3-94, 10.13.2 

41. ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14,
3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

42. ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-04,
2.3; CSA A23.3-94, 10.0

43. ACI 318-14, 6.6.4.4.4, Eq. 6.6.4.4.4b; ACI 318-11, 10.10.6 Eq. 10-14; ACI 318-08, 10.10.6 Eq. 10-14;
ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-14, 10.16.3.2, 10.15.3 Eq.
10-19; CSA A23.3-04, 10.16.3.2, 10.15.3 Eq. 10-18; CSA A23.3-94, 10.16.3.2, 10.15.3.1 Eq. 10-18

k ℓ r/ ≥ 22.0u

k ℓ r/ < 100u
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reinforcement. Assuming that shear due to lateral loads is not sustained in most frames44,
the βds is taken as zero (with the exception of strength and stability of the structure as a

whole under factored gravity loads described in Step 11).

7. The critical buckling load, Pc, is computed as45.

8. The sway moment magnification factor, s, is computed as46:

where the stiffness reduction factor, ϕK, is equal to 0.75.

ΣPu is taken as the factored axial load for the load combination under consideration times

the ratio ΣPu/Pu, i.e.47 ΣPu = Pu (ΣPu/Pu).

ΣPc is taken as the critical buckling load for the load combination under consideration

times the ratio ΣPc/Pc, i.e. ΣPc = Pc (ΣPc/Pc).

ϕK and the ratios ΣPu/Pu and ΣPc/Pc may be modified using the Slenderness Factors

input box. 

9. The magnified moments at the top and bottom ends of the compression member are

computed as48:

10. The smaller and the larger factored end moments are then determined based on absolute
values of magnified top and bottom end moments

44.ACI 318-14, R6.6.4.6.2(b); ACI 318-11, R10.10.7.4; ACI 318-08, R10.10.7.4; ACI 318-05, R10.13.4.1,
R10.13.4.3; ACI 318-02, R10.13.4.1, R10.13.4.3; Ref. [10] pp 586 (first paragraph from the bottom)

45.ACI 318-14, 6.6.4.4.2, Eq. 6.6.4.4.2; ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13;
ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-14, 10.16.3.2, 10.15.3.1 Eq.
10-18; CSA A23.3-04, 10.16.3.2, 10.15.3.1 Eq. 10-17; CSA A23.3-94, 10.16.3.2, 10.15.3 Eq. 10-17

46. ACI 318-14, 6.6.4.6.2, Eq. 6.6.4.6.2b; ACI 318-11, 10.10.7.4 Eq. 10-21; ACI 318-08, 10.10.7.4 Eq. 10-
21; ACI 318-05, 10.13.4.3 Eq. 10-18; ACI 318-02, 10.13.4.3 Eq. 10-18; CSA A23.3-14, 10.16.3.2
Eq. 10-24; CSA A23.3-04, 10.16.3.2 Eq. 10-23; CSA A23.3-94, 10.16.3.2 Eq. 10-23

47. To minimize required input, the program uses one value of ratio Pu / Pu for all load combinations.

However, the ratio can vary depending on the combination under consideration. In this case, it will be
conservative to use the highest value of the ratio.

48. ACI 318-14, 6.6.4.6.1; ACI 318-11, 10.10.7; ACI 318-08, 10.10.7; ACI 318-05, 10.13.3; ACI 318-02,
10.13.3; CSA A23.3-14, 10.16.2; CSA A23.3-04, 10.16.2; CSA A23.3-94, 10.16.2
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While design codes define moment M2 as always positive and the sign of moment M1

depending on single or double curvature bending49, spColumn retains actual signs of
moments M1 and M2. This revision ensures proper comparison against negative and

positive moment capacities of unsymmetrical sections (see Figure 2-8).

11. Strength and stability of the structure as a whole under factored gravity loads50 is ensured
by checking that the value of the moment magnification factor, s. is positive and does not

exceed 2.5. 

The program performs this check for all load combinations that include only gravity loads
with the exception of the ACI 318-14/11/08 codes for which the check is not performed
and CSA A23.3-94 where the check is performed only for the load combination of 1.25
dead load plus 1.5 live load plus (1.5 snow or 0.0 snow), if this combination is present
(default). The βd factor for the load combination under consideration is equal to the

maximum sustained factored axial load to the maximum factored axial load.

2.6 Moment Magnification along Length of 
Compression Member

This procedure accounts for moment magnification due to second-order effect along the length of

compression members that are part of either nonsway51 or sway frames52. In nonsway frames,
moment magnification along length is neglected by the program if the condition in Step 3 is
satisfied. 

49. ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14,
3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

50. ACI 318-05, 10.13.6; ACI 318-02, 10.13.6; CSA A23.3-14, 10.16.5; CSA A23.3-04, 10.16.5; CSA
A23.3-94, 10.16.5

51. ACI 318-14, 6.6.4.4.2, 6.6.4.5.1, 6.6.4.5.2; ACI 318-11, 10.10.6; ACI 318-08, 10.10.6; ACI 318-05,
10.12; ACI 318-02, 10.12; CSA A23.3-14, 10.15; CSA A23.3-04, 10.15; CSA A23.3-94, 10.15

52. ACI 318-14, 6.6.1.1; ACI 318-11, 10.10.2.2; ACI 318-08, 10.10.2.2; ACI 318-05, 10.13.5; ACI 318-02,
10.13.5; CSA A23.3-14, 10.16.4; CSA A23.3-04, 10.16.4; CSA A23.3-94, 10.16.4
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In sway frames designed per ACI 318-02/05 and CSA A23.3-94/04/14, the magnification along

the length is neglected if53:

By rearranging and introducing , this condition can be succinctly expressed as

. For columns designed per ACI 318-14, ACI 318-11, and ACI 318-08 codes, moment
magnification along length is to be considered for all slender compression members, i.e. columns

in either nonsway or sway frames regardless of the  ratio. Since various published examples
of columns designed per ACI 318-14, ACI 318-11, and ACI 318-08 do not combine moment

magnification at ends and along length of columns in sway frames54, spColumn optionally allows
not considering moment magnification along the length of a column in a sway frame based on
engineering judgment of the user.

When moment magnification along the length of a compression member is considered, the
following procedure is followed:

1. The effective length factor, k, is either entered by the user or calculated by the program.
The value of k must be between 0.5 and 1.0 for moment magnification along length and

the recommended55 value is 1.0. Smaller values can be used if justified by analysis. If
properties of framing members are input, spColumn computes the effective length factor,

k, for nonsway condition from the following equation56:

Where ψ is the ratio of ∑(EI/ℓc) of columns to ∑(EI/ℓ) of beams in a plane at one end of

the column, ψA and ψB are the values of ψ at the upper end and the lower end of the
column, respectively. Moments of inertia used in computing ψ factors are gross moments

of inertia multiplied by the cracked section coefficients57 (specified in the Slenderness

53. ACI 318-05, Eq. 10-19; ACI 318-02, Eq. 10-19; CSA A23.3-04, Eq. 10-26; CSA A23.3-04, Eq. 10-25;
CSA A23.3-94, Eq. 10-25

54. See Example 11.2 in Ref. [9], Example 12.4 in Ref. [11], and Example 12.3 in Ref. [10]
55. ACI 318-14, 6.6.4.4.3, R6.6.4.4.3; ACI 318-11, 10.10.6.3, R10.10.6.3; ACI 318-08, 10.10.6.3,

R10.10.6.3; ACI 318-05, 10.12.1; ACI 318-02, 10.12.1; CSA A23.3-14, 10.15.1; CSA A23.3-04,
10.15.1; CSA A23.3-94, 10.15.1

56. Exact formula derived in Ref. [12] pp. 848 for Jackson and Moreland alignment chart
57. ACI 318-14, 6.6.3.1.1, 6.6.4.2, 6.7.1.3, 6.8.1.4; ACI 318-11, 10.10.4.1; ACI 318-08, 10.10.4.1; ACI 318-

05, 10.11.1, 10.12.1; ACI 318-02, 10.11.1, 10.12.1; CSA A23.3-14, 10.14.1.2, 10.15.1; CSA A23.3-04,
10.14.1.2, 10.15.1; CSA A23.3-94, 10.14.1, 10.15.1
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Factors dialog box). 

2. Moments at column ends, M1 and M2, are calculated, where M1 is the moment with the

smaller absolute value and M2 is the moment with the larger absolute value. For columns

in nonsway frames, the end moments will be equal to the factored applied first order
moment. For columns in sway frames, the end moments will be the moments M1 and M2

calculated in the procedure for moment magnification at ends of compression member.
While design codes define moment M2 as always positive and the sign of moment M1

depending on single or double curvature bending58, spColumn retains actual signs of
moments M1 and M2 to ensure proper comparison of resulting magnified moments against

negative and positive moment capacities of unsymmetrical sections (see Figure 2-8). This
revised interpretation does not affect results of the moment magnification along length
procedure because the procedure relies on the M1/M2 ratio. spColumn follows the code

definition which assumes the ratio to be positive if the member is bent in single curvature
and negative if bent in double curvature. If both moments are equal to zero, the program
conservatively assumes the ratio of M1/M2=1.0.

3. Second-order effects along length for columns in nonsway frames can be ignored if: 

 for ACI codes59,

and

, for the CSA standards60,

where ℓu is the unsupported column length,  is the radius of gyration, and the

ratio M1/M2 is always taken as greater than or equal to –0.5. 

4. If the ratio  exceeds 100, slenderness effects cannot be accounted for using moment

magnification procedure61. A more exact method must be used. In this case, the program
issues a warning message and aborts design or investigation procedure except for

calculations per ACI 318-14, ACI 318-11, and ACI 318-08 where limit of 
does not explicitly apply and the program continues calculations after showing the
warning message.

58. ACI 318-14, 2.1; ACI 318-11, 2.1; ACI 318-08, 2.1; ACI 318-05, 2.1; ACI 318-02, 10.0; CSA A23.3-14,
3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

59.ACI 318-14, 6.2.5; ACI 318-11, 10.10.1; ACI 318-08, 10.10.1; ACI 318-05, 10.12.2; ACI 318-02,
10.12.2

60.CSA A23.3-14, 10.15.2; CSA A23.3-04, 10.15.2; CSA A23.3-94, 10.15.2
61.ACI 318-05, 10.11.5; ACI 318-02, 10.11.5; CSA A23.3-14, 10.13.2; CSA A23.3-04, 10.13.2; CSA

A23.3-94, 10.13.2
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5. The factor Cm is computed as62:

and for codes other than ACI 318-14, ACI 318-11, and ACI 318-08, Cm is taken as not

less than 0.4.

If M1=M2=0, the program assumes Cm to be equal to 1.063. This is consistent with the

assumption made above (in Step 2).

6. The sustained load factor βdns (βd for ACI 318-05/02 and CSA A23.3-14/04/94) is

computed as the ratio of maximum factored axial sustained load to the maximum factored
axial load for the load combination under consideration for compression members either

in nonsway64 or sway65 frames. The value of βdns is not taken greater than 1.0.

7. Flexural stiffness EI is computed as66:

where Ec is the modulus of elasticity of concrete, Es is the modulus of elasticity of steel, Ig

is the gross moment of inertia of the concrete section, and Ise is the moment of inertia of

reinforcement.

8. The critical buckling load, Pc is computed as67:

9. The magnification factor for moment along length, δ, is computed as68:

62. ACI 318-14, 6.6.4.5.3; ACI 318-11, 10.10.6.4; ACI 318-08, 10.10.6.4; ACI 318-05, 10.12.3.1; ACI 318-
02, 10.12.3.1; CSA A23.3-14, 10.15.3.2; CSA A23.3-04, 10.15.3.2; CSA A23.3-94, 10.15.3.1

63. ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-
02, 10.12.3.2

64. ACI 318-14, 6.6.4.4.4; ACI 318-11, 10.10.6.2; ACI 318-08, 10.10.6.2; ACI 318-05, 10.11.1; ACI 318-
02, 10.0; CSA A23.3-14, 3.2; CSA A23.3-04, 2.3; CSA A23.3-94, 10.0

65. ACI 318-14, 6.6.1.1; ACI 318-11, 10.10.2.2, 10.10.6.2; ACI 318-08, 10.10.2.2, 10.10.6.2; ACI 318-05,
10.13.5; ACI 318-02, 10.13.5; CSA A23.3-14, 10.14.1.3(a), 10.16.4; CSA A23.3-04, 10.14.1.3(a),
10.16.4; CSA A23.3-94, d definition (a) in 10.0, 10.16.4

66.ACI 318-14, 6.6.4.4.4 Eq. 6.6.4.4.4(b); ACI 318-11, 10.10.6.1 Eq. 10-14; ACI 318-08, 10.10.6.1 Eq. 10-
14; ACI 318-05, 10.12.3 Eq. 10-11; ACI 318-02, 10.12.3. Eq. 10-10; CSA A23.3-14, 10.15.3 Eq. 10-19;
CSA A23.3-04, 10.15.3 Eq. 10-18; CSA A23.3-94, 10.15.3.1 Eq. 10-18

67.ACI 318-14, 6.6.4.4.2,  Eq. 6.6.4.4.2; ACI 318-11, 10.10.6 Eq. 10-13; ACI 318-08, 10.10.6 Eq. 10-13;
ACI 318-05, 10.12.3 Eq. 10-10; ACI 318-02, 10.12.3 Eq. 10-10; CSA A23.3-14, 10.15.3.1 Eq. 10-18;
CSA A23.3-04, 10.15.3.1 Eq. 10-17; CSA A23.3-94, 10.15.3 Eq. 10-17
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where the stiffness reduction factor, ϕk, is equal to 0.75 (may be modified using the

Slenderness Factors input box) and Pu is the factored axial load for the load combination

under consideration.

10. The moment due to minimum eccentricity, emin is computed as69:

Mmin= Pu emin, where

emin= 0.6 + 0.03h , with h in inches,

emin= 15 + 0.03h , with h in mm, 

and h is the section dimension (diameter for circular sections) in the direction being
considered.

11. The factored magnified moment along the length of a compression member, Mc, is the

larger70 of δM2 and δMmin. The program also calculates moment Mc based on the smaller

end moment, M1, to account for scenario when M1 and M2 are of different sign (double

curvature bending). For an unsymmetrical section, the smaller moment, M1, may govern

the design when the moment capacity on the negative side of the interaction diagram is
smaller than the moment capacity on the positive side (see Figure 2-8).

68. ACI 318-14, 6.6.4.5.2 Eq. 6.6.4.5.2; ACI 318-11, 10.10.6 Eq. 10-12; ACI 318-08, 10.10.6 Eq. 10-12;
ACI 318-05, 10.12.3 Eq. 10.9; ACI 318-02, 10.12.3 Eq. 10.9; CSA A23.3-14, 10.15.3.1 Eq. 10-17; CSA
A23.3-04, 10.15.3.1 Eq. 10-16; CSA A23.3-94, 10.15.3 Eq. 10-16

69. ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI
318M-05, 10.12.3.2; ACI 318-02, 10.12.3.2; ACI 318M-02 10.12.3.2; CSA A23.3-14, 10.15.3.1; CSA
A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3.

70. ACI 318-14, 6.6.4.5.4; ACI 318-11, 10.10.6.5; ACI 318-08, 10.10.6.5; ACI 318-05, 10.12.3.2; ACI 318-
02, 10.12.3.2; CSA A23.3-14, 10.15.3.1; CSA A23.3-04, 10.15.3.1; CSA A23.3-94, 10.15.3

δ 1.0
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m
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Figure 2-8 Case of unsymmetrical section bent in double curvature (M1 and M2 of 

different sign) with the smaller end moment, M1, governing the design

2.7 Moments Magnification Ratio

For calculations in accordance with ACI 318-14/11/08, the value of total magnified moment
including second-order effects (combined magnification at ends and along length of compression

member) cannot exceed 1.4 times the corresponding moment due to first order effects71. Columns
with second-order moment to first-order moment ratios exceeding 1.4 do not meet requirements of
ACI 318-14/11/08.

The ratio of second-order moment, M2nd, to first-order moment M1st is calculated for both values

(i =1, 2) of magnified moment along length, , i.e. based on M1 and M2:

71. ACI 318-14, 6.2.6; ACI 318-11, 10.10.2.1; ACI 318-08, 10.10.2.1

δM1 M1 M2 δM2

Axial Load,
P

Moment, M

Mci
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Cutoff value of Mmin is applied to  in order to avoid unduly large ratios in cases where 

moments are smaller than Mmin.

If only magnification at ends is considered (i.e. when user chooses to bypass provision 10.10.2.2
of ACI 318-14/11/08 and ignores second order effects along the length of a compression member
in a sway frame), the ratio of second-order moment, M2nd, to first-order moment, M1st, is

calculated at both ends (i =1, 2) as:

where Mi are the magnified end moments M1 and M2, and are the corresponding factored

applied moment composed of the part that causes no appreciable sidesway, Mins, and the part that

causes appreciable sidesway, Mis. If both  and  moments are equal to zero, the

program will report the ratio equal to 1.0. If only  moment is equal to zero, the program will

report the ratio as a large value.
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3.1 spColumn Interface

The spColumn Interface will appear after the program is started as shown below. The
spColumn Interface consists of a Control Menu, Title Bar, Menu Bar, Toolbar,
Information Bar, Graphics Bar, and a Status Bar. The program name and current data file
name is shown in the Title Bar. All the menu commands can be accessed from the Menu Bar
and some frequently used commands also can be accessed from the buttons in the Toolbar.
The Status Bar shows the current state of the program.

Figure 3-1 Main Window

Control Menu

The Control menu is located in the upper-left corner of the window and includes commands
for sizing, moving, enlarging, restoring, and closing the window, as well as switching to other
applications. To access the Control menu using the mouse, click the left mouse button on the
box; using the keyboard, press ALT+ SPACEBAR.

Title Bar

The Title Bar displays the name of the application (spColumn in this case), along with the
name of the current data file in use. If the data has not been saved into a file, the word Untitled
is displayed in the Title Bar.
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Menu Bar

The Menu Bar is located directly beneath the Title Bar. It lists the available menus. There is
a total of 6 distinct drop-down menus accessible from the Menu Bar. The majority of
commands appearing in the drop-down menus are also accessible via the program’s Main
Window area.

Toolbar

The Toolbar is located directly below the Menu bar. It contains a collection of buttons (or
icons) that provide a shortcut to accessing the menu commands. The Toolbar buttons can only
be accessed using the mouse. 

Information Bar

The Information bar is located on the left side of the spColumn window. The top part displays
the column cross section. The bottom part is a list of selected input data echo. 

Graphics Area

The Graphics Area covers most of the window. This is where the interaction diagram is
shown.

Status Bar

The Status Bar is located directly beneath the program’s Main Window area. It displays
important information such as units, design code, cursor position, and helpful messages.

3.2 File Menu

The File menu gives access to file operations, printing
operations and to exiting the spColumn program. 

New (CTRL+N)

Clears any input data and returns the data to the default
values so that a new data file may be input.

Open (CTRL+O)

Opens an existing data file. 

Save (CTRL+S)

Saves the changes you have made to the current input file under that same filename. 
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Save As

Enables you to name or rename a data file. 

Import

Reads geometry, reinforcement or loads data from an ASCII (TXT) file, or imports section
geometry and reinforcement from a DXF file.

Export 

Exports interaction diagram and 3D failure surface to Comma-Separated Values (CSV) files
(readable by most spreadsheet programs) or Tab-Delimited Text (TXT) files. Exports a
column section to Drawing Exchange Format (DXF) file (readable by most CAD programs).
Exports graphical report (screen printout) to Enhanced Metafile Format (EMF) file (readable
by most graphics and word processing programs).

Revert 

Discards any changes to the data file and returns to the most recently saved version of the data
file. This option will only be available if the data file has been previously saved and there have
been modifications done on the data file since. Do not save the data file immediately prior to
reverting otherwise this command will have no effect. 

Print Report

Provides the option to print Default report or Customize the report before printing.

Print Screen (CTRL+P)

Prints the graphical image displayed in the Graphics/Input Area of the Main Window.
Displays Print dialog box and prints the results similarly as they appear on the screen.

Recent Data File List

Provides quick access to up to four recently open data files.

Exit 

Ends the spColumn program. If you have made any changes to your data and have not saved
them, spColumn will prompt you whether you want to save or abandon any changes you have
made before you exit.
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3.3 Input Menu

The Input Menu includes commands used to input the data needed
to define a problem. The Input Menu contains the following
commands: General Information, Material Properties, Section,
Reinforcement, Slenderness, Loads, and Flip/Rotate Section.

General Information 

The General Information command allows you to enter the
project, column and engineer names. It also allows the selection of
units, run options, run axis and slenderness consideration.

Material Properties 

The Material Properties command enables you to input material properties for concrete and
reinforcing steel.

Section

Rectangular: Input the dimensions of a rectangular section.

Circular: Input the diameter of a circular section.

Irregular: Initiates spSection module to define an irregularly shaped section. Available under
investigation option only. See Chapter 6 for spSection module.

Reinforcement 

All Sides Equal: Input a reinforcement pattern in which all the bars are of one size, and the
number of bars is the same on all four sides of a rectangular layout or are equally spaced for a
circular layout. Number of bars should be enter as multiple of four (4). Available for
rectangular and circular sections.

Equal Spacing: Input a reinforcement pattern in which all bars are of one size and are
uniformly spaced on all four sides of a rectangular layout. Number of bars should be entered
as multiple of four (4). Available for rectangular sections only.

Sides Different: Input a reinforcement pattern in which each one of the four sides of a
rectangular section has a certain number of bars and a certain bar size. Available for
rectangular sections only.

Irregular Pattern: Input a reinforcement pattern in such a way that bars of any size can be
placed anywhere within the column section.
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Confinement: Input confinement-related data such as the capacity reduction factors and the
size of ties associated with the longitudinal bar size.

Design Criteria: Input parameters that govern the design of the section such as column type,
minimum and maximum reinforcement ratio, bar selection criterion, minimum clear spacing,
and design/required ratio.

Slenderness 

Design Column: Input data needed for slenderness related to the column being considered.

Column Above/Below: Input data needed for slenderness related to the columns above and
below the design column.

X-Beams: Input data needed for slenderness related to beams perpendicular to the x-axis
framing into the design column at top and bottom joints.

Y-Beams: Input data needed for slenderness related to beams perpendicular to the y-axis
framing into the design column at top and bottom joints.

Factors: Slenderness factors related to stiffness reduction factor and cracked-section
coefficients. Code defaults are selected by default. However, user-defined selection is also
available.

Loads 

Factored: Input factored axial loads and moments. This option is available for non-slender
columns only.

Service: Input service-level (dead, live, wind, earthquake, and snow) axial loads and moments
about the active axis. Moments are input at the top and at the bottom of the column. This
option is available for both slender and non-slender columns.

Control Points: If chosen, the program will compute key points on the interaction diagram. In
addition, the splice regions are shown on the interaction diagram. This option is available for
non-slender columns under the investigation option only. Also the splice lines are only shown
for uniaxial runs.

Axial Loads: Input a group of axial loads with an initial value, a final value, and an increment.
This option is available for uniaxial non-slender columns under the investigation option only.

Load Combinations: Input the load factors and combinations used to combine the service
loads. 

Flip/Rotate Section 

Flip an unsymmetrical section about an axis or rotate an irregular section (created in
spSection).
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3.4 Solve Menu

The Solve Menu contains the command to execute the
design or investigation calculations along with options
that control inclusion of nominal capacity calculations,
tracing through the design process, and creating the
classic results file. The Solve Menu contains the
following commands: Execute, Include Nominal Diagram, Design Trace, and Results File. 

Execute (F5) 

Executes the Solver. 

Include Nominal Diagram

Toggles INCLUDE NOMINAL DIAGRAM option on and off.

Design Trace 

Toggles DESIGN TRACE option on and off. 

Classic Results File 

Toggles CLASSIC RESULTS FILE option on and off.
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3.5 View Menu

The View menu commands can be used to customize the
display screen to suit your viewing needs and enable you
to view the result diagrams. The View menu contains the
following commands: Results, Reporter, Redraw,
Copy Diagram to Clipboard, Information Bar, Tool
Bar, Status Bar, Grid, Mx-My Diagram, P-M
Diagram - Full, P-M Diagram - M Positive, P-M
Diagram - M Negative, P-M Diagram - 3D, Next
Load, Previous Load, Next Angle, Previous Angle,
Show Load Point Labels, Show Splice Lines, Show
Normal Diagram, Superimpose...

Results (F6)

Executes the spResults module to view the input and
output data after a successful run has been performed.

Reporter (F7)

Executes the spReporter module to generate and print reports after a successful run has been
performed.

Redraw 

Redraws the displayed diagrams or contours.

Copy Diagram to Clipboard (CTRL+C)

Copies the displayed diagram or contour to clipboard so that in can be pasted in other
applications.

Information Bar 

Shows or hides the Information Bar. 

Tool Bar 

Shows or hides the Tool Bar. 

Status Bar 

Toggles the Status Bar at the bottom of the screen on or off. 



spColumn INTERFACE

| 51 |

Grid 

Shows or hides the Grid. 

Mx-My Diagram 

View a contour of the failure surface sliced at a constant axial load. 

P-M Diagram - Full

View an interaction diagram sliced at a constant (Mx, My) angle drawn for both positive and

negative moments.

P-M Diagram - M positive

View an interaction diagram sliced at a constant (Mx, My) angle drawn for the positive

moments only.

P-M Diagram - M negative

View an interaction diagram sliced at a constant (Mx, My) angle drawn for the negative

moments only.

P-M Diagram – 3D

View a three dimensional visualization of the complete nominal and factored failure surface
for sections subject to biaxial bending.

Next Load (Ctrl + Arrow Up)

View an Mx-My interaction diagram for the factored load next to the one displayed currently

on the interaction diagram.

Previous Load (Ctrl + Arrow Up)

View an Mx-My interaction diagram for the factored load previous to the one displayed

currently on the interaction diagram.

Next Angle

View a P-M interaction diagram for the (Mx, My) angle next to the one currently displayed on

the interaction diagram.

Previous Angle

View a P-M interaction diagram for the (Mx, My) angle previous to the one currently displayed

on the interaction diagram.
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Show Load Point Labels

Show/Hide Load Point labels of loads input.

Show Splice Lines

Show the P-M splice lines corresponding to fs = 0 and fs = 0.5fy.

Show Nominal Diagram

Show nominal (unfactored) capacity interaction diagram in addition to the design (factored)
capacity interaction diagram. Available only when Include Nominal Diagram option is
selected in the Solve menu.

Superimpose 

Superimpose an interaction diagram from a previously saved run over the current interaction
diagram. 

3.6 Options Menu

The Options menu allows you to change the startup options of the
spColumn program to suit your needs. The Options menu contains
the following commands: Startup Defaults and Reinforcement.

Startup Defaults

The Startup Defaults command allows you to change the default system of units, design
code, reinforcement database, and the data directory which is where the program looks for data
when it is executed.

Reinforcement

View or Edit reinforcing bar set.
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3.7 Help Menu

The Help menu includes commands that enable you to obtain online
help for the program and show the copyright and registration
information about your software. 

spColumn Info

Opens information page for the current version of spColumn being
used in the default browser. Internet connection is required.

Submit a Question

Opens “Submit a Question” page where you can ask questions on
Technical, Licensing, Sales, Pricing or other topics via e-mail. Internet connection is required.

Manual

Opens spColumn Manual in the default browser. Internet connection is required.

Help

Uses the default browser to open spColumn Help. It provides access to all available help
topics. Click on any topic and a help screen will appear with information about that item.
Internet connection is required.

Tutorial Videos

Uses the default browser to open a page containing spColumn tutorial videos. Internet
connection is required.

Design Examples

Uses the default browser to open a page containing design examples for StructurePoint
software. Internet connection is required.

Check for Updates

Checks if a newer version of spColumn is available. Internet connection is required.

Release Notes

Uses default browser to open a page containing release notes for the version of spColumn
being used. Internet connection is required.
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About spColumn

Shows the version number of the program, the licensing information, and the copyright
information. In the case of a trial license, the expiration date is given as well as the locking
code which is needed to obtain a standalone license.
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4.1 Introduction

In this chapter, the sections follow the order in which commands and options appear beginning
with those found under the File menu and ending with those under the Help menu.

Many of the commands and options that appear under these menus are also accessible by other
methods. Consequently, these other methods are also explained. 

4.2 Creating New File

When spColumn is loaded, the program is ready to begin receiving input for a new project. Until
you save the file, the data will not have a filename associated with it, and the title bar will display
the word Untitled as illustrated here: 

• From the File menu, choose New. This clears the screen in preparation for a new project
or data entry file and returns the program to its default settings. 

• If existing data on an open project has been changed prior to executing the New command,
the program will display the following message box inquiring whether you wish to save
the data on the open project or data file before creating a new file:

4.3 Opening File

spColumn allows you to open data files that were saved at an earlier time including files from
previous versions of spColumn as well as pcaColumn. Note that the extension name of a
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pcaColumn and spColumn file is .COL. spColumn also opens files with the spColumn Text Input,
.CTI, extension.

• From the File menu, choose Open and a dialog box will appear.

• All files with the COL extension contained in the current drive and directory are displayed

in the FILE NAME list box. To view files with the .CTI72 extension use the file type drop-
down menu to choose the .CTI extension.

• To open a file that exists in another drive or directory, select the drive or directory you
want from the LOOK IN drop-down list.

• From the FILE NAME list box, select the file to be opened, or simply type its name in the
text box. 

• Choose the OK button.

• Alternatively, an input file can be opened by spColumn if the file is drag-and-dropped
onto the program window or if the file pathname is provided as a command line parameter
when invoking spColumn from the command prompt.

4.4 Saving File

spColumn files are saved in a binary format with .COL or .CTI extensions. 

72.For more information see "spColumn Text Input (CTI) file format" on page 176. 
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4.4.1 Save the data with the same file name

• At any time while editing a data file that has previously been saved under a file name,
choose File and Save to save the changes under the same file name, overwriting the old
file. From the File menu, select the Save command before giving the data file a name
displays the Save As dialog box.

4.4.2 Change format or rename the file

• From the File menu, select Save As, and a dialog box will appear.

• All files with .COL extensions contained in the current drive and directory are displayed
in the FILE NAME list box.

• To save the file to a drive or directory other than the default, select a different drive or
directory drive from the SAVE IN drop-down list.

• Use FILE TYPE list box to select either spColumn Input File, .COL, or spColumn Text
Input File, .CTI.

• In the FILE NAME text box, type a new file name. If no file extension is specified, an
extension will be appended to the specified file name based on the selected file type.

• Choose the OK button.
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4.5 Most Recently Used Files (MRU)

The Most Recently Used Files (MRU) list shows the four data files that were opened most
recently. Selecting a data file from this list makes it easier and faster to open the file. The list is
empty when the program is executed for the first time.

4.6 Importing

4.6.1 Importing Data

Geometry, reinforcement or load data may be imported from a text file.
The import file must be saved in pure ASCII (text) format.73

• Select File | Import | Import Data… or press CTRL + I
keyboard shortcut to display IMPORT DATA dialog box.

• Select the type of data you want to import: SERVICE LOADS,
FACTORED LOADS, REINFORCEMENT OR GEOMETRY.

• Choose the OK button. The Open Import file box is displayed.

• All files with the TXT extension contained in the current drive and directory are displayed
in the FILE NAME list box.

• To open a file that exists in another drive or directory, select the drive or directory you
want from the LOOK IN drop-down list.

• From the File Name list box, select the file to be opened, or simply type its name in the
text box. 

• Choose the OPEN button.

73.For more information see "spColumn Text Input (CTI) file format" on page 176. 
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4.6.2 Importing DXF Files

• Select File | Import | Import DXF…. to display Open Import file box.

• All files with the DXF extension contained in the current drive and directory are displayed
in the FILE NAME list box.

• To open a file that exists in another drive or directory, select the drive or directory you
want from the LOOK IN drop-down list.

• From the File Name list box, select the file to be opened, or simply type its name in the
text box. 

• Choose the OPEN button.

• The basic IMPORT MODEL FROM DXF FILE dialog box is displayed.

• Press OK button.

The advanced IMPORT MODEL FROM DXF FILE dialog box can be displayed by clicking
Advanced >> button in the basic view and is shown below.
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If the DXF file (or selected layer) contains a closed polyline entity (either LWPOLYLINE or
POLYLINE) it will be interpreted as the section outline. If multiple closed polylines are present
then the first two will be automatically recognized as the outline and the opening and the rest will
be ignored. 

Reinforcing bars are derived from DXF circle entities (CIRCLE). If no closed polylines are
present then the first circle entity will be interpreted as a circular shape of the column and the rest
will be interpreted as reinforcing bars.

Dimensions of imported entities will be automatically converted to current project units based on
DXF header variable $INSUNITS if the “Use unit from DXF file” option is checked otherwise the
DXF file will be assigned the user defined length units and unit system which will then be
converted to the current project units.
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4.7 Exporting

Once a successful run has been performed you may export results
data of the following:

1. Points from the interaction diagram or 3D failure surface to a
Comma-Separated Values (CSV) file or to a Tab Delimited
Text file (TXT). These files can be read by most spreadsheet
and mathematical programs where data produced by
spColumn can be further analyzed and processed as needed by the user. Coordinates of the
points (P, Mx, My) are saved together with corresponding location of the neutral axis

(depth and angle), maximum steel strain, and (for ACI code) strength reduction factor. 

2. The column section can be exported to a file in Drawing Exchange Format (DXF) format
that is readable by most CAD programs. 

3. A graphical report can be exported to a file in Enhanced Metafile Format (EMF) that is
readable by most graphics and word processing programs. The file will include column
section, column information, and the interaction diagram currently displayed on the screen
presented the same way as in the printout created by the default printer using the File |
Print Screen command. The following steps are used to export various output data:

• Select File | Export | Factored Interaction Diagram to export P-M or Mx-My diagram

currently displayed on the screen.

• Select File | Export | Factored 3D Failure Surface to export 3D failure surface (biaxial
runs only).

• Select File | Export | Nominal Interaction Diagram to export nominal (unfactored) P-M
or Mx-My diagram corresponding to the one currently displayed on the screen.

• Select File | Export | Nominal 3D Failure Surface to export nominal (unfactored) 3D
failure surface (biaxial runs only).

• Select File | Export | Column Section to DXF File to export column section to DXF file

• Select File | Export | Graphical Report to EMF File to export graphical report to EMF
file.

• For interaction diagrams and 3D failure surface, use FILE TYPE list box to select either
Comma-Separated Values (CSV) file or Tab Delimited Text file (TXT). For sections, only
DXF format is available and for graphical reports, only EMF format is available.

• In the FILE NAME text box, type the file name. If no file extension is specified, an
extension will be appended to the specified file name based on the selected file type.
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• Choose the SAVE button.

4.8 Revert

Discards any changes to the data and returns to the last version of saved data. This option will only
be available if the file has been modified since the last file save.

4.9 Printing

Once a successful run has been performed you may print the diagram displayed on the screen
using File | Print Screen command. You may print the report using File | Print Report | Default
Report. If you select File | Print Report | Customized Report you will be taken to the
spReporter module.

4.9.1 Print Screen

• Select File | Print Screen. A dialog box appears.

• Select the printer to send the diagram displayed on the screen to.

• Use Print dialog controls to set up the printer options.

• Choose the OK button to start the printing or choose the CANCEL to terminate the print
job.
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4.9.2 Print Report

• Select File | Print Report | Default Report. A dialog box appears.

• Select the printer to send the report to.

• Use the PROERTIES button to access and modify the printer options if required.

• choose the OK button to start printing or CANCEL to terminate the print job.
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4.10 General Information

The General Information command allows you to define or
change options that will affect the rest of the input. 

• Select Input | General Information. A dialog box
appears.

• Enter the PROJECT, COLUMN, and ENGINEER labels. 

• Select the units of measure, ENGLISH or METRIC. 

• Select the axis about which the column capacity is to
be computed: ABOUT X-AXIS, ABOUT Y-AXIS, or
BIAXIAL. 

• Select a design code to conform to: ACI 318-14, ACI
318-11, ACI 318-08, ACI 318-05, ACI 318-02, CSA
A23.3-14, CSA A23.3-04 or CSA A23.3-94. 

• Choose a run option: INVESTIGATION or DESIGN. 

• Specify whether slenderness effects are to be
considered or not by checking either YES or NO under
the CONSIDER SLENDERNESS? option. 

• Choose the OK button.

4.11 Material Properties

• Select Input | Material Properties. A dialog box appears.

• Enter the concrete compressive strength, f’c under STRENGTH, f’c. The modulus of

elasticity, Ec, under ELASTICITY, Ec; the constant stress intensity, fc at the maximum

usable strain used to calculate the force on concrete, under MAX STRESS, fc; the factor
used to determine the depth of the stress block, under BETA(1); and the maximum usable
strain at the extreme concrete compression fiber, at the ULTIMATE STRAIN are
automatically computed and displayed. Modify any of the values if different than
computed. 

• For the reinforcing steel, enter the yield strength, fy under STRENGTH, fy. The modulus of

elasticity, Es under the ELASTICITY, Es, as well as Compression-controlled strain limit,

Eps_yt are automatically computed and displayed. Modify any of the values if different
than computed.
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• Choose the OK button to accept standard or modified values based on user’s judgment.

4.12 Section / Rectangular

4.12.1 Input for the Investigation Option:

• Select Input | Section | Rectangular. A dialog box appears.

• Enter the width and depth of the rectangular section using
WIDTH (ALONG X) and DEPTH (ALONG Y) respectively. Note
that width is measured along the x-axis and depth is measured
along the y-axis.

• Choose the OK button

4.12.2 Input for the Design Option: 

• Select Input | Section | Rectangular. A dialog box
appears.

• Enter the starting and ending values for each dimension
(width and depth) along with an increment for each
dimension under START, END and INCREMENT columns
along WIDTH (ALONG X) and DEPTH (ALONG Y). Note
that the starting and ending values may be the same (in
which case the increment must be zero). 

• Choose the OK button.
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4.13 Section/Circular

4.13.1 Input for the Investigation Option: 

• Select Input | Section | Circular. A dialog box appears.

• Enter the diameter of the column section. 

• Choose the OK button. 

4.13.2 Input for the Design Option: 

• Select Input | Section | Circular. A dialog box
appears.

• Enter the starting and ending values of the diameter
along with an increment. Note that the starting and
ending values may be the same (in which case the
increment must be zero).

• Choose the OK button.

4.14 Reinforcement/All Sides Equal

The Input | Reinforcement | All Sides Equal command allows you to enter the total number of
bars in the column section. The program attempts to place equal number of bars on each side of a
rectangular layout then equally space them on each side. For a circular layout, the program
attempts to equally space the bar.

4.14.1 Input for the Investigation Option:

• Select Input | Reinforcement | All Sides Equal. A
dialog box appears. 

• Enter the total number of bars in the section NO. OF

BARS (Must be at least 4 and a multiple of 4).

• Select the bar size.

• Enter the clear cover and specify whether it is to the
transverse bars (ties) or to the longitudinal bars. 

• Select a bar layout, CIRCULAR or RECTANGULAR.
The default is CIRCULAR for a circular section and RECTANGULAR for a rectangular
section. 
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• Choose the OK button

4.14.2 Input for the Design Option

• Select Input | Reinforcement | All Sides
Equal. A dialog box appears.

• Enter the minimum and maximum total number
of bars in the section (must be at least 4 and a
multiple of 4 for a rectangular layout).

• Select the minimum and maximum bar sizes
along with the clear cover. 

• Enter the clear cover and specify whether it is to the transverse bars (ties) or to the
longitudinal bars. 

• Select a bar layout, Circular or Rectangular. The default is CIRCULAR for a circular section
and RECTANGULAR for a rectangular section. 

• Choose the OK button.

4.15 Reinforcement/Equal Spacing

The Input | Reinforcement | Equal Spacing command allows you to enter the total number of
bars in the column section. The program attempts to place the bars equally spaced on all four sides
of a rectangular layout. This command is only applicable for rectangular sections.

4.15.1 Input for the Investigation Option: 

• Select Input | Reinforcement | Equal Spacing. A
dialog box appears.

• Enter the total number of bars in the section NO. OF

BARS. (Must be at least 4 and a multiple of 4). 

• Select the bar size. 

• Enter the clear cover and specify whether it is to the
transverse bars (ties) or to the longitudinal bars. 

• Choose the OK button. 

4.15.2 Input for the Design Option: 

• Select Input | Reinforcement | Equal Spacing. A dialog box appears. 
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• Enter the minimum and maximum total number of bars in the section under MINIMUM and
MAXIMUM corresponding to NO. OF BARS. (must be at least 4 and a multiple of 4).

• Select the minimum and maximum bar sizes. 

• Enter the clear cover and specify whether it is to the transverse (ties) or to the longitudinal
bars.

• Choose the OK button. 

4.16 Reinforcement/Sides Different

4.16.1 Input for the Investigation Option: 

• Select Input | Reinforcement | Sides Different. A
dialog box appears. 

• Enter the number of bars to be placed on each of the
top, bottom (on the top and bottom, number of bars
needs to be at least 2), left and right sides (on the left
and right, the number of bars may be any number) of
the rectangular section. Note that corner bars are
associated with the top and bottom sides. 

• Select the bar size and enter the clear cover for each
of the top, bottom, left and right sides of the section. 

• Specify whether the clear cover entered is to the transverse (ties) or to the longitudinal
bars. 

• Choose the OK button. 

4.16.2 Input for the Design Option:

• Select Input | Reinforcement | Sides Different. A dialog box appears. 
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• In the Top and Bottom Group

– Enter the minimum and maximum total number of bars to be placed on the top and 
bottom sides. 

– The number of bars must be greater than 4 and a multiple of 2. Corner bars are associ-
ated with the top and bottom sides.

– Select the minimum and maximum bar size and enter the clear cover. 

• In the Left and Right Group

– Enter the minimum and maximum total number of bars to be placed on the Left and 
Right sides. The minimum and maximum number of bars can be set to zero (0) or must 
be multiple of 2.

– The minimum and maximum bar size entries are inactivated, therefore, follows the 
entries for Top and Bottom Group.

– Enter the clear cover.

• Specify whether the clear cover entered is to the transverse (ties) or to the longitudinal
bars. 

• Choose the OK button. 

4.17 Reinforcement/Irregular Pattern

The Input | Reinforcement | Irregular Pattern command allows you to specify any number of
bars (up to 10,000) to be placed anywhere within the column section. Each bar may have any
cross-sectional area. This command is available with the Investigation option only.
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• Select Input | Reinforcement | Irregular Pattern. If
the section is irregular, The spSection window, where
the section reinforcement may be graphically input, is
displayed. Otherwise, a dialog box appears.

• Enter the bar area, along with its x- and y-coordinates. 

• Choose the INSERT button. The data are added to the
list box. 

• Repeat the steps above for each entry. 

• To edit an entry, select it from the list box, modify its
values in the text boxes, and choose the MODIFY

button. To change the area for several bars at once,
select those bars from the list box, enter the new area
in the AREA text box, and choose MODIFY. 

• To delete a bar entry, select it from the list box and choose the DELETE button. 

• Choose the OK button. 

4.18 Reinforcement/Confinement

• Select Input | Reinforcement | Confinement. A
dialog box appears. 

• Select the type of bar confinement: TIED (default),
SPIRAL, or Other. The capacity reduction factors
change depending on the selection. 

• To modify the capacity reduction factors, choose
OTHER for confinement type. 

For the ACI code: 

Phi(a) is the reduction factor for allowable compression, 

Phi(b) is the strength reduction factor for tension
controlled failure,

Phi(c) is the reduction factor for compression controlled
failure.

For the CSA code:

Phi(a) is the reduction factor for allowable compression,
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Phi(s) is the material resistance factor for steel,

Phi(c) is the material resistance factor for concrete.

• Specify the tie size associated with the particular longitudinal bar sizes. The code
requirements are used as defaults.

• Choose the OK button.

Note that if confinement is selected as TIED or SPIRAL then the program will automatically adjust
the factors when the user changes the design code. However, if OTHER confinement is selected,
the factors will not be adjusted. 

For CSA A23.3-14, the reduction factor for allowable compression is variable (shown as VAR)
and for irregular sections the wall thickness or minimum column dimension must also be
specified.

4.19 Reinforcement / Design Criteria

• Select Input | Reinforcement | Design Criteria. A
dialog box appears. This command is available with
the Design option only.

• Specify whether the column is to be considered
STRUCTURAL (default), ARCHITECTURAL, or OTHER.
Notice that the minimum and maximum
reinforcement ratios change depending on the
selection.

• Choose whether bar selection is to be based on
MINIMUM NUMBER OF BARS (default) or on MINIMUM

AREA OF STEEL.

• To modify the limiting reinforcement ratios, choose
OTHER. Enter the minimum and maximum
reinforcement ratios in the corresponding text boxes. 

• Enter the minimum clear bar spacing and the design-to-required ratio. 

• Choose the OK button.
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4.20 Slenderness / Factors

• Select Input | Slenderness | Factors. A dialog box appears.
Note: this command is available for slender columns only. 

• The default values, per the design code, for the stiffness
reduction factor (used to compute the moment magnification
factors) and the cracked section coefficients for beams and
columns are displayed. To modify these values, select the
USER-DEFINED option and enter your values. 

• Choose the OK button. 

4.21 Slenderness / Design Column

• Select Input | Slenderness | Design Column. A dialog box appears. The x-axis or y-axis
data groups may be disabled depending on the active run axis. Note: this command is
available for slender columns only. 

• Enter the clear column height in the corresponding text box.

• Specify whether the column is braced against sidesway or not by selecting or clearing the
NONSWAY FRAME option.

• For a sway column, enter the ratio of the sum
of the critical load of all story columns to the
critical load of the column under
consideration, (SUM PC)/PC. Also, enter the
ratio of the sum of the factored axial load of
all story columns to the factored axial load of
the column under consideration, (SUM PU)/

PU. Check 2ND ORDER EFFECTS ALONG

LENGTH option to consider 2nd order effects
along length. Note: this option is available for
ACI 318-14, ACI 318-11, and ACI 318-08
codes only. For more information see
"Moment Magnification along Length of
Compression Member" on page 35. 

• In the EFFECTIVE LENGTH FACTORS group, specify whether the k factor(s) are to be user-
input or computed by the program, by selecting the corresponding option.
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• If you chose INPUT K FACTORS, enter the effective length factors for nonsway and sway
conditions, k(ns) and k(s), respectively.

• Repeat the steps above for each active axis.

• Choose the OK button.

4.22 Slenderness / Columns Above and Below

• Select Input | Slenderness | Columns Above/Below. A dialog box appears. Note: this
command is available for slender columns only for which the COMPUTE K FACTORS

option is selected in the DESIGN COLUMN dialog box. 

• In the COLUMN ABOVE group, specify whether or not a column above the design column
exists, by selecting or clearing the NO COLUMN SPECIFIED OPTION. 

• If a column above exists; enter the center-to-center height, the width (along the x-axis), the
depth (along the y-axis), the concrete compressive strength, and the concrete modulus of
elasticity of the column above in the corresponding text boxes. For circular sections, enter
zero for the DEPTH and input the section diameter in the WIDTH box. If zero is entered for
both Width and Depth, the dimensions of the design column will be automatically used.

• Repeat the same for the column below or, if the column above and the column below are
the same, choose the COPY TO COLUMN BELOW button.

• Choose the OK button. 
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4.23 Slenderness / X-Beams

• Select Input | Slenderness | X-Beams. A
dialog box appears. Beams defined using
this command span perpendicular to the x-
axis. Note: this command is available for
slender columns only for which the
COMPUTE K FACTORS option is selected in
the DESIGN COLUMN dialog box and the
RUN AXIS is BIAXIAL or uniaxial ABOUT X-
AXIS.

• From the BEAM LOCATION group, choose
the appropriate option. The data group
below updates depending on the selection. 

• For the selected beam, specify whether or
not a beam exists, by selecting or clearing
the NO BEAM SPECIFIED OPTION. 

• If a beam exists; enter the center-to-center span length, width, depth, concrete
compressive strength, concrete modulus of elasticity, and moment of inertia (if different
than computed) of the beam. 

• Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, and BELOW RIGHT. 

• Choose the OK button. 
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4.24 Slenderness / Y-Beams

• Select Input | Slenderness | Y-Beams. A dialog
box appears. Beams defined using this command
span perpendicular to the y-axis. Note: this
command is available for slender columns only
for which the COMPUTE K FACTORS option is
selected in the DESIGN COLUMN dialog box and
the RUN AXIS is BIAXIAL or uniaxial ABOUT Y-
AXIS. 

• From the BEAM LOCATION group, choose the
appropriate option. The data group below
updates depending on the selection. 

• For the selected beam, specify whether or not a
beam exists, by selecting or clearing the NO

BEAM SPECIFIED OPTION. 

• If a beam exists; enter the center-to-center span length, width, depth, concrete
compressive strength, concrete modulus of elasticity, and moment of inertia (if different
than computed) of the beam. 

• Repeat the steps above for the beams ABOVE RIGHT, BELOW LEFT, and BELOW RIGHT. 

• Choose the OK button.

4.25 Loads / Factored

When designing or investigating a non-slender column, factored loads consisting of applied axial
loads and moments about the active axis may be input. This command is not available for slender
columns.
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• Select Input | Loads | Factored. A dialog box appears. 

• Enter the factored axial load in the LOAD text box. 

• Based on the active axis, enter the factored moment
about the x-axis, X-MOMENT, the factored moment
about the y-axis, Y-MOMENT, or both. 

• Choose the INSERT button. The data are added to the
list box. 

• Repeat the steps above for each factored load entry. 

• To edit an entry, select it from the list box, modify its
values in the text boxes, and choose the MODIFY

button. 

• To delete an entry, select it from the list box and choose
the DELETE button. 

• Choose the OK button.

4.26 Loads / Service

When designing or investigating a non-slender or slender column, service level loads consisting of
dead, live, lateral (wind and earthquake), and snow axial loads and moments at both column ends
about the active axis may be input. These loads are then factored and combined based on the load
combinations. 

• Select Input | Loads | Service. A dialog box appears. 

• For each of the load cases: Dead, Live, Wind, Earthquake (EQ), and Snow, enter the axial
load and the applicable moment (about x or y) at the column top and bottom. 

• Enter the percentage of the sustained part of the load in each load case (by default only
Dead Load is assumed to be 100% sustained). These percentages will be used to arrive at
sustained axial load ratio dns to calculate moment magnification factor along length of

the column74.

• Choose the INSERT button. The data are added to the list box. 

• Repeat the steps above for each entry. 

74.For moment magnification at ends of a column in a sway frame, the value of βds is assumed to be zero 

and is not affected by sustained load factors (For more information see "Moment Magnification at Ends of 
Compression Member" on page 32. )
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• To edit an entry, select it from the list box, modify its values in the text boxes, and choose
the MODIFY button. 

• To delete an entry, choose it from the list box and choose the DELETE button.

• Choose the OK button. 

4.27 Loads / Control Points

A non-slender column may be investigated without inputting any loads. The capacity of the
section is computed along with other section capacity parameters. This command is not available
for slender columns or under the Design option. 

• Select Input | Loads | Control Points.

In the output file, key points (e.g. balanced point and pure bending) on the interaction 
diagram are listed. For each point, the axial load and bending moment capacities, along 
with the corresponding neutral axis depth, distance from extreme compression fiber to 
centroid of extreme layer of longitudinal tension steel, net tensile strain in extreme layer of 
longitudinal tension steel at nominal strength, and strength reduction factor (ACI only) are 
listed. For a biaxial run, these points are listed for bending about positive and negative X 
and Y axes.
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For ACI code, the program flags the unusual increase in axial load capacity in transition 
zone between the balanced point and the tension control point.

For uniaxial runs, the bar splice requirements for columns75 are indicated on the 
interaction diagram.

4.28 Loads / Axial Loads

When investigating a non-slender column (uniaxial runs only), grouped factored applied axial
loads may be input. The corresponding moment capacity for each load is computed and output.
This command is not available under the DESIGN option, for biaxial runs, or if the column is
slender. 

• Select Input | Loads | Axial Loads. A dialog box
appears. 

• To input a range of axial loads, enter the initial, final
and increment values in the corresponding text boxes.
To input a discrete (single) axial load, enter its value in
the INITIAL text box, and enter zero in the FINAL and
INCREMENT text boxes. 

• Choose the INSERT button. The data are added to the list
box.

• Repeat the steps above for each axial load entry you
may have.

• To edit an entry, select it from the list box, modify its
values in the text boxes, and choose the MODIFY

button. 

• To delete an entry, choose it from the list box and choose the DELETE button. 

• Choose the OK button

75. ACI 318-14, Fig. R10.7.5.2; ACI 318-11, Fig. R12.17; ACI 318-08, Fig. R12.17; ACI 318-05, Fig. 
R12.17; ACI 318-02, Fig. R12.17; CSA A23.3-14, 12.17.3; CSA A23.3-04, 12.17.3; CSA A23.3-94, 
12.17.3 
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4.29 Loads / Load Combinations

spColumn allows you to specify up to 50 load combinations. The service load input under the load
cases (dead, live, wind, earthquake, and snow) are combined based on these combinations. A
minimum of one combination must be input.

• Select Input | Loads | Load Combinations.
A dialog box appears. For a new file, the
default combinations per the selected code are
shown in the list box. 

• To add a new combination, enter the load
factors or multipliers for each load case,
DEAD, LIVE, WIND, Earthquake (EQ), and
SNOW. 

• Choose the INSERT button. The data are added
to the list box. 

• Repeat the steps above for each load
combination. Up to fifty combinations may be
defined. 

• To edit an entry, select it from the list box,
modify its values in the text boxes, and
choose the MODIFY button. 

• To delete an entry, choose it from the list box
and choose the DELETE button. 

• Choose OK when done.

4.30 Flipping / Rotating the 
Section

This command is available for Irregular sections and for sections with Sides Different or Irregular
reinforcement. 
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• Select Input | Flip/Rotate Section. A dialog box appears.

• Select one of the options: FLIP SECTION ABOUT X-AXIS,
FLIP SECTION ABOUT Y-AXIS, or ROTATE SECTION. The
last option is available for irregular sections only. 

• If ROTATE SECTION is selected, enter the angle of rotation
(clockwise is positive).

• Choose the OK button.

4.31 Executing a Run

4.31.1 From the program

• Select Solve | Classic Results File. This is an option
that may be turned ON or OFF by choosing it again.
With this option ON, an output file will be created
while the program is solving. The output file is a text
file that contains an echo of the input along with
slenderness calculation output, load combinations, and
the critical points on the interaction diagram. 

• Select Solve | Include Nominal Diagram. This is an option that may be turned ON or
OFF by choosing it again. With this option ON, calculations of nominal (unfactored)
capacity interaction diagram will also be included in the calculations so that the nominal
diagram can be viewed and exported in addition to the design (factored) capacity diagram.

• Select Solve | Design Trace (design option only). This is an option that may by turned ON
or OFF be choosing it again. With this option ON, if designing a column section, the
program will pause at each cross section and reinforcement layout it tries, and display the
cross section with its bars in the Information bar. 

• Select Solve | Execute. If more data are needed to solve the problem, an error box appears
and you will be prompted for the required data. If all the needed data are input, the solver
portion of spColumn will start executing. The Solving box appears with a progress
indicator. Click Cancel to terminate the solution process. After a successful run, the
interaction diagram or the contour plot is displayed in the Graphics area of the window. 
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4.31.2 From the command prompt

spColumn run can also be executed in batch mode from the command line prompt. Input data file,
output data file, and run options can be passed to the program via parameters. For instance typing
spColumn /i:Examples\Example01.col will run spColumn and solve the column
defined in input file Example01.col.

Multiple cross-sections can be designed and analyzed by executing spColumn with multiple input
files using batch (BAT) files (see Examples.bat in the spColumn program folder). Combined with
Column Text Input files (CTI), this feature can be used for automation spColumn runs for projects
involving large numbers of cross-sections.

Help on how to use command line parameters can be obtained by typing spColumn /? at the
command prompt.
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4.32 Viewing Results

Once a successful run has been performed, you may view the results file. 

• Select View | Results. spColumn executes the spResults module. Alternatively you can
also access spResults by pressing the F6 key.
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• Use the explorer, options in the toolbar or the “PAGEUP” and “PAGEDOWN” buttons to
navigate through the data tables.

• You can click the CLOSE button in the top right corner to exit spResults window.

4.33 Changing Startup Defaults

You can change some default settings that spColumn uses when it is started or when the File | New
command is executed.

• Select Options | Startup Defaults. A dialog box appears.

• Enter the full path of the directory to which spColumn
defaults when opening a data file. 

• Select the system of units, design code, and reinforcement
to be used as defaults whenever a new file is started. 

• Enter the number of lines per page to be used in
formatting the classic results file. 

• Choose the SAVE button to save these options in the
registry.
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4.34 Changing Reinforcement Bar Set

• Select Options | Reinforcement. A dialog box
appears

4.34.1 Select a different set

• From the BAR SET drop-down list, select the set to
be used.

• Choose the OK button.

4.34.2 Create or modify a user-defined 

set

• From the BAR SET drop-down list, select USER-
DEFINED. The ADD, DELETE and MODIFY buttons
are enabled. 

• To edit an entry, select it from the list box, modify
its values, and choose the MODIFY button. 

• To delete an entry, select it from the list box and
choose the DELETE button. 

• To add an entry, enter the bar size, diameter, area
and unit weight in the corresponding text box, and
choose the ADD button. The data are added to the list box. 

• A user-defined set may be saved to disk for use in other files. To do so, choose the SAVE

button after inputting the bars. The bar set is saved to the file specified by the user. To
retrieve a saved set, choose the READ button.

• Choose the OK button.

4.35 Superimposing Diagrams

After executing a run and selecting the File | Save command, the program saves the diagram data
in a separate file that has the same file name as the input file, with an IAD extension. If
calculations of nominal interaction diagram are included, the program stores also the nominal
diagram data in an additional IAD file named as the input file name suffixed with “-nominal.iad”.
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The IAD interaction diagram file may be later read by the program and two diagrams (of different
files) may be superimposed for the purpose of comparison. Note that the RUN AXIS (uniaxial or
biaxial) of the two files must be the same. 

• Select View | Superimpose option. The open dialog box appears. 

• All files with the IAD extension contained in the current drive and directory are displayed
in the FILE NAME list box. To open a file that exists in another drive or directory, select a
different drive or directory drive from the LOOK IN drop-down list. 

• From the FILE NAME list box, select the file to be opened, or simply type its name in the
text box. 

• Choose the OK button. If the data is successfully read, the diagram from the IAD file
(shown dotted) is superimposed over the currently displayed diagram. 

• To clear the superimposed diagram, uncheck the View | Superimpose option. 

4.36 Viewing 2D Diagrams

By default, the program displays diagrams based on the design (factored) section capacity.
Display of diagrams based on the nominal (unfactored) strength is controlled by the View | Show
Nominal Diagram option which is available when calculations of nominal diagram are activated
using the Solve | Include Nominal Diagram option.

For a uniaxial run, the program computes and displays the P-M interaction diagram. For a biaxial
run, the program computes the three-dimensional failure surface (P, Mx, My). The failure surface
can be viewed in one of two ways:

a) P-M interaction diagram (vertical slice at an angle measured from Mx) 

b) Mx-My contour curve (horizontal slice at a constant axial load).

Whenever the mouse cursor moves over the Graph area, the axial load, moment, and eccentricity
are displayed in the Status bar.
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4.36.1 Viewing P-M Interaction Diagram 

• Select View | P-M Diagram - Full. A dialog box
appears. 

• You may also select View | P-M Diagram – M
positive or View | P-M Diagram – M negative to
view the interaction diagram only for positive or
negative moments.

• Specify whether you want to enter an angle or the
values of the moments that produce a view angle
by selecting either the ANGLE or MOMENTS option,
respectively.

• If the ANGLE option was selected, select an angle
from the list, use the scroll bar to pick an angle, or
simply enter the value in the text box. 

• If the MOMENTS option was selected, enter the values of Mx and My which define the view

angle. The value of that view angle is computed and shown in the ANGLE text box. 

• To display all load points and their numbers check the LIST POINT NUMBERS option. To
display unique angle values only, leave the option unchecked.

• Choose the OK button.

• You may browse through the angles by using View | Next angle and View | Previous
angle respectively. 

4.36.2 Viewing Mx-My Contours

• Select View | Mx-My Diagram. A dialog box appears.

• Select an axial load from the list, use the scroll bar to pick a load,
or simply enter the value in the text box.

• To display all load points and their numbers check the LIST

POINT NUMBERS option. To display unique axial load values
only, leave the option unchecked.

• Choose the OK button.

• You may browse through the loads by using View | Next Load
and View | Previous Load respectively.
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4.37 Viewing 3D Failure Diagrams

• Select View | P-M Diagram - 3D. A dialog window appears launching the spColumn 3D
viewer.

4.37.1 Main Menu

Export as Image

Exports the image as a PNG file to supplement calculation or reports.

Exit

Exits the 3D View window.

4.37.2 View Menu

Toolbar

Provides five options to determine the location and size of the toolbar.

Settings

Provides the user with options to modify general and color settings. 

In General Settings, user controls are provided for general, failure surface, planes, and camera
options. 

In Colors Settings, user controls are provided for factored surface, nominal surface, load
points, main axes angles, axis, and cutter plane options.
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View Controls

Shows or hides the view controls. Arrows in the upper right corner provide controls for the
location or the tool and extent of functions. The icons show in blue when active. View controls
provide the following operator functions:

• Show and hide 3D rotation cube.

• Rotate section in 3D (shift + middle mouse button)

• Zoom to workspace

• Zoom in (mouse wheel)

• Zoom out (mouse wheel)

• Pan (middle mouse button)

Status Bar

Shows or hides the status bar. Status bar is located at the bottom of the screen and displays the
design code, the load values at the cursor location, and the units. 
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4.37.3 Toolbar - General

Exit

Exits the 3D View window. 

Export

Exports the image as a PNG file to supplement calculation or reports. 

4.37.4 Toolbar - Tools

Cut Horiz. - Create horizontal cross section tool

Allows to cut the failure surface at desired height and investigate the inside of it. 

Cut Vertical - Create vertical cross section tool

Allows to cut the failure surface at desired angle and investigate the inside of it. 

4.37.5 Toolbar - Options

Pointer

Allows to investigate the failure surface and read column’s load capacity.

Nominal Surface

Shows or hides nominal surface.

Factored Surface

Shows or hides factored surface.

Load Points

Shows or hides load points.

Settings

Modifies settings for general, and colors. Refer to View Menu for more information on
settings.
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spColumn 3D View
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spColumn 3D View - Failure surface horizontal cross section

spColumn 3D View - Failure surface vertical cross section
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5.1 Example 1 - Capacity of a Square Column

5.1.1 Problem Formulation

For a column section76 which is 16” x 16” and reinforced with 4-#8 bars, calculate the load 
moment capacities for the following load conditions:

Case 1: Bar stress near tension face of member equal to zero, (fs = 0). 

Case 2: Bar stress near tension face of member equal to 0.5fy, (fs = 0.5fy) 

Case 3: At limit for compression controlled sections. (εs = 0.002) 

Case 4: At limit for tension controlled sections. (εs = 0.005)

Given a concrete of 4 ksi and reinforcing steel of 60 ksi.

5.1.2 Preparing Input

• From the File menu, choose New. Any input data is cleared 
and the default values are restored. 

• From the Input menu, choose General Information. 

- Input the PROJECT header. 

- Select ENGLISH units and ACI 318-14 code. 

- Select About X-axis for run axis, Investigation for run option and No for Consider
slenderness? 

- Choose OK.

76. Based on Example 6.4, pp 6-33 from Notes on ACI 318-11 Building Requirements for Structural Con-
crete with Design Applications, Edited by Mahmoud E. Kamara and Lawrence C. Novak, Twelfth Edi-
tion, 2013, Portland Cement Association.
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5.1.3 Assigning Properties

• From the Input menu, choose Material 
Properties. 

- Accept the default properties as they
match those in the problem statement 

- Choose OK.

• From the Input menu, choose Section | 
Rectangular. 

- For the section WIDTH (ALONG X), input 16

- For the section DEPTH (ALONG Y), input 16.

- Choose OK.

• From the Input menu, choose Reinforcement | All 
Sides Equal

- Input 4-#8 bars under NO. OF BARS. 

- Input 1.5 in for the CLEAR COVER and select
TRANSVERSE BARS under COVER TO.

- Choose OK.

• From the Input menu, choose Loads | Control 
Points. 

5.1.4 Solving

• From the Solve menu, choose Execute. 

- The P-MX contour is displayed in the Graphics area. 
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5.1.5 Viewing and Printing Results

• From the View menu, choose Results. 

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

• From the File menu, choose Print Report | Default Report. 

- Select the printer to send the default report to.

- Choose PRINT.

• From the File menu, choose Print Screen. 

- Select the printer to send the graphical results to.

- Choose PRINT



EXAMPLES

| 100 |



EXAMPLES

| 101 |

STRUCTUREPOINT - spColumn v6.00 Page | 3
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example01.col 10:33 AM

1. General Information
File Name C:\Program Files

(x86)\Structure...\Example01.col
Project spColumn Manual Example 1
Column PCANotes 6.4
Engineer SP
Code ACI 318-14
Bar Set ASTM A615
Units English
Run Option Investigation
Run Axis X - axis
Slenderness Not Considered
Column Type Structural

2. Material Properties
2.1. Concrete
Type Standard
f'c 4 ksi
Ec 3605 ksi
fc 3.4 ksi
εu 0.003 in/in
β1 0.85

2.2. Steel
Type Standard
fy 60 ksi
Es 29000 ksi
εyt 0.00206897 in/in

3. Section
3.1. Shape and Properties
Type Rectangular
Width 16 in
Depth 16 in
Ag 256 in2

Ix 5461.33 in4

Iy 5461.33 in4

rx 4.6188 in
ry 4.6188 in
Xo 0 in
Yo 0 in
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STRUCTUREPOINT - spColumn v6.00 Page | 4
Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example01.col 10:33 AM

3.2. Section Figure

Rectangular 16 x 16 in 1.23% reinf.

Figure 1: Column section

4. Reinforcement
4.1. Bar Set: ASTM A615

Bar Diameter Area Bar Diameter Area Bar Diameter Area
in in2 in in2 in in2

#3 0.38 0.11 #4 0.50 0.20 #5 0.63 0.31
#6 0.75 0.44 #7 0.88 0.60 #8 1.00 0.79
#9 1.13 1.00 #10 1.27 1.27 #11 1.41 1.56
#14 1.69 2.25 #18 2.26 4.00

4.2. Confinement and Factors
Confinement type Tied
For #10 bars or less #3 ties
For larger bars #4 ties

Capacity Reduction Factors
Axial compression, (a) 0.8
Tension controlled failure, (b) 0.9
Compression controlled failure, (c) 0.65

4.3. Arrangement
Pattern All sides equal
Bar layout Rectangular
Cover to Transverse bars
Clear cover 1.5 in
Bars 4 #8

Total steel area, As 3.16 in2

y

x
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Licensed to: StructurePoint. License ID: 00000-0000000-4-25EF2-228DB 9/19/2017
C:\Program Files (x86)\StructurePoint\spColumn v6.00\spColumn\Examples\Examples-Ma...\Example01.col 10:33 AM

rho 1.23 %
Minimum clear spacing 10.25 in

5. Control Points
About Point P X-Moment Y-Moment NA Depth dt Depth εt Φ

kip k-ft k-ft in in
X @ Max compression 682.0 0.00 0.00 43.90 13.63 -0.00207 0.65000
X @ Allowable comp. 545.6 72.20 0.00 15.81 13.63 -0.00041 0.65000
X @ fs = 0.0 467.6 102.64 0.00 13.63 13.63 0.00000 0.65000
X @ fs = 0.5 fy 331.8 135.43 0.00 10.13 13.63 0.00103 0.65000
X @ Balanced point 238.9 148.49 0.00 8.06 13.63 0.00207 0.65000
X @ Tension control 188.7 172.04 0.00 5.11 13.63 0.00500 0.90000
X @ Pure bending 0.0 91.03 0.00 2.24 13.63 0.01528 0.90000
X @ Max tension -170.6 0.00 0.00 0.00 13.63 9.99999 0.90000
-X @ Max compression 682.0 0.00 0.00 43.90 13.63 -0.00207 0.65000
-X @ Allowable comp. 545.6 -72.20 0.00 15.81 13.63 -0.00041 0.65000
-X @ fs = 0.0 467.6 -102.64 0.00 13.63 13.63 0.00000 0.65000
-X @ fs = 0.5 fy 331.8 -135.43 0.00 10.13 13.63 0.00103 0.65000
-X @ Balanced point 238.9 -148.49 0.00 8.06 13.63 0.00207 0.65000
-X @ Tension control 188.7 -172.04 0.00 5.11 13.63 0.00500 0.90000
-X @ Pure bending 0.0 -91.03 0.00 2.24 13.63 0.01528 0.90000
-X @ Max tension -170.6 0.00 0.00 0.00 13.63 9.99999 0.90000
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5.2 Example 2 - Investigation of a Slender Column - 
Nonsway Frame

5.2.1 Problem Formulation

Determine the adequacy of a 14” x 20” column77 with 6-#11 bars in a nonsway frame with a clear 
height of 22’6”. Use k=1.0.

The concrete used is 4.5 ksi and the reinforcing steel is 50 ksi.

The factored load values for the column under consideration are as follows:

5.2.2 Preparing Input

From the File menu, choose New. Any input data is cleared and 
the default values are restored.

• From the Input menu, choose General Information. 

- Input the PROJECT header. 

- Select ENGLISH units and ACI 318-14 code. 

- Select Biaxial for run axis, Investigation for run option
and Yes for Consider Slenderness?

- Choose OK. 

77. Based on Example 15.8.5 from Reinforced Concrete Design by Chu-Kia Wang, Charles G. Salmon, and 
Jose A. Pincheira, Seventh Edition, 2007, John Wiley and Sons, Inc.

P (kip) 115 kips

Top Muy (kip-ft) 279 k-ft

Bottom Muy (kip-ft) -279 ft-kips
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5.2.3 Assigning Properties 

• From the Input menu, choose Material 
Properties.

- Input 4.5 for the CONCRETE STRENGTH.
Change the REINFORCING STEEL

STRENGTH to 50. Other properties are
computed and will be accepted. 

- Choose Ok.

• From the Input menu, choose Section | Rectangular. 

- Input 20 and 14 for the section width (along X) and depth
(along Y). 

- Choose OK.

• From the Input menu, choose Reinforcement 
| Sides Different. 

- Input 2-#11 bars for TOP and BOTTOM

and 1-#11 for LEFT and RIGHT. Input
1.5 in for the cover and select
LONGITUDINAL BARS. 

- Choose OK. 

• From the Input menu, choose Slenderness | 
Design Column. 

- Input 22.5 for the column CLEAR HEIGHT. 

- Check NONSWAY FRAME and select INPUT ‘k’ FACTORS. Input 1 for k.

- Press COPY TO Y-AXIS.

- Choose OK.



EXAMPLES

| 106 |

• From the Input menu, choose Loads | Service. 

- Under LIVE, input 71.875 for the AXIAL LOAD, 0 for the X-MOMENTS @TOP, 0 for
the X-MOMENTS @BOT, 174.375 for the Y-MOMENTS @TOP and -174.375 for the
Y-MOMENTS @BOTTOM, respectively. 

- In column SUSTAINED LOAD keep default setting for dead load equal 100%.

- Choose INSERT to add the entry to the list box. 

- Choose OK.
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• From the Input menu, choose Loads | Load 
Combinations. 

- If the list displays thirteen combinations, choose
only the second load combination U2 and delete
all the others by selecting them and using
DELETE. Choose OK.

5.2.4 Solving

• From the Solve menu, choose Execute. 

- The solver of the program is started and, upon
completion, displays the interaction diagram of
the section with the load point plotted within the
diagram. 

5.2.5 Viewing and Printing Results

• From the View menu, choose Results. 

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

• From the File menu, choose Print Report | Default Report. 

- Select the printer to send the default report to.

- Choose PRINT.

• From the File menu, choose Print Screen. 

- Select the printer to send the graphical results to.

- Choose PRINT.
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2.1. Concrete

2.2. Steel

3.1. Shape and Properties
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3.2. Section Figure

4.1. Bar Set: ASTM A615

4.2. Confinement and Factors

4.3. Arrangement



EXAMPLES

| 112 |

4.4. Bars Provided

5.1. Load Combinations

5.2. Service Loads

5.3. Sustained Load Factors

6.1. Sway Criteria

6.2. Columns

6.3. X - Beams
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6.4. Y - Beams

7.1. General Parameters

7.2. Effective Length Factors

7.3. Magnification Factors: X - axis

7.4. Magnification Factors: Y - axis

8.1. X - axis
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8.2. Y - axis
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5.3 Example 3 - Design of a Slender Column - Sway 
Frame

5.3.1 Problem Formulation

Design a square column78 with a clear height of 16 ft. The column is sway and subjected to dead, 
live and wind loads as shown below.

The column is to be checked for the following load combinations:

U1 = 1.2 D + 1.6 L
U2 = 1.2 D + 0.5 L + 1.6 W

The calculations in the reference are done based on the load combination U2.

In practice, the ratio Pc/Pc would have to be calculated before 
the problem can be attempted, using a trial value of Pc/Pc. Here, 
the value of Pc/Pc used is 28.67 based on the reference value of 
Pc. There are 14 interior columns, 18 exterior columns and 4 
corner columns. Therefore, the value of Pu/Pu = 14 + 18 * 2/
3 + 4 * 1/3 = 27.33 irrespective of the load combination being 
used.

5.3.2 Preparing Input

• From the File menu, choose New. Any input data is 
cleared and the default values are restored. 

• From the Input menu, choose General Information

- Input the PROJECT header. 

78. Based on Example 12.4, pp 409, from Structural Concrete: Theory and Design by M. Nadim Hassoun 
and Akthem Al-Manaseer, Fourth Edition, 2008, John Wiley and Sons, Inc.

Dead Live Wind

P (kip) 380 140 0

Top Mx (kip-ft) 32 20 50

Bottom Mx (kip-ft) 54 36 50
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- Select English units and ACI 318-14 code. 

- Select About X-Axis for run axis, Design for run option and Yes for Consider
slenderness?

- Choose OK.

5.3.3 Assigning Properties

• From the Input menu, pick Material Properties. 

- Input 5 for the concrete strength. Other properties are computed and will be accepted. 

- Choose OK. 

• From the Input menu, pick Section | Rectangular. 

- Input 18 and 18 for the WIDTH (ALONG X) and DEPTH

(ALONG Y) under both START and END options. 

- Choose OK.

• From the Input menu, choose Reinforcement | All 
Sides Equal

- Input 4-#10 bars for Minimum, and 40-#10
bars for Maximum and 1.5 in for the cover,
and select TRANSVERSE BARS and
RECTANGULAR Bar Layout.

- Choose OK.
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• From the Input menu, choose Slenderness | Design Column.

- Input 16 for the column CLEAR HEIGHT. 

- Check SWAY FRAME 

- Under SWAY CRITERIA, input 28.67 and 27.33 for the Pc/Pc and Pu/Pu,
respectively. 

- Leave 2ND ORDER EFFECT ALONG LENGTH option checked (default)

- Select COMPUTE ‘K’ FACTORS.

- Choose OK.
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• From the Input menu, choose 
Slenderness | Columns Above/Below.

- Clear the NO COLUMN SPECIFIED

option. 

- Input 11 for the column height
(center-to-center) under HEIGHT (C/C)
and leave the other data as is. 

- Choose Copy to Column Below. 

- Choose OK.

• From the Input menu, choose 
Slenderness | X-Beams.

- Choose ABOVE LEFT. 

- Clear the NO BEAM SPECIFIED option. 

- Input 20 for the span (center-to-center) under
SPAN(C/C). 

- Input 0.00 and 0.00 for the WIDTH and
DEPTH, respectively. 

- Input 21436.6 for the moment of inertia
under INERTIA. 

- Leave the other data as it is. 

- Choose ABOVE RIGHT and click on COPY FROM BEAM LEFT. 

- Choose BELOW LEFT and click on COPY FROM BEAM ABOVE. 

- Choose BELOW RIGHT and click on COPY FROM BEAM ABOVE. 

- Choose OK. 

• From the Input menu, choose Loads | Service.

- Under DEAD, input 380, 32 and -54 for the AXIAL LOAD, X-MOMENTS @ TOP and
X-MOMENTS @ BOT respectively.

- Under LIVE, input 140, 20 and -36 for the AXIAL LOAD, X-MOMENTS @ TOP and X-
MOMENTS @ BOT, respectively. 

- Under WIND, input 0, 50 and -50 for the AXIAL LOAD, X-MOMENTS @ TOP and X-
MOMENTS @ BOT, respectively. 
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- Under SUSTAINED LOAD keep the default settings of 100% for dead and 0% for all
other load cases.

- Choose INSERT to add the entry to the list box. 

- Choose OK.
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• From the Input menu, choose Loads | Load 
Combinations.

- Select all load combinations by clicking on
U1 and dragging to U13. Then choose
DELETE.

- Enter 1.2 for Dead, 1.6 for Live, and 0.5
for Snow then choose INSERT. 

- Enter 1.2 for Dead, 0.5 for Live, 1.6 for
Wind, and 0.5for Snow then choose INSERT. 

- Choose OK.

5.3.4 Solving

• From the Solve menu, choose Execute. 

- The solver of the program is started and, upon
completion, displays the interaction diagram
of the section with the load points plotted
within the diagram.

5.3.5 Viewing and Printing Results

• From the View menu, choose Results. 

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

• From the File menu, choose Print Report | Default Report. 

- Select the printer to send the default report to.

- Choose PRINT.

• From the File menu, choose Print Screen. 

- Select the printer to send the graphical results to.

- Choose PRINT.
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2.1. Concrete

2.2. Steel

3.1. Shape and Properties
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3.2. Section Figure

4.1. Bar Set: ASTM A615

4.2. Design Criteria

4.3. Confinement and Factors

4.4. Arrangement
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5.1. Load Combinations

5.2. Service Loads

5.3. Sustained Load Factors

6.1. Sway Criteria

6.2. Columns

6.3. X - Beams
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7.1. General Parameters

7.2. Effective Length Factors

7.3. Magnification Factors: X - axis

8.1. X - axis
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5.4 Example 4 - Investigation of Concrete Shear 
Wall Capacity

5.4.1 Problem Formulation

Investigate the axial load and moment capacity of a shear wall79 for a given location of the neutral 
axis. Use 4-ksi concrete and 60-ksi reinforcing steel.

spColumn provides a comprehensive model editor for irregular shapes. For this example, 
however, a specific tool provided with spColumn will be used for frequently needed shapes.

• From the Start Menu, go to All Programs | StructurePoint | spColumn and run Design 

Assistant80.

• Design Assistant uses macros to export data to text files. If a macro warning is displayed 
when opening Design Assistant, make sure macros are enabled in order for the exporting 
function to work properly.

79. Based on Example 4-4, pp 333, from Seismic and Wind Forces Structural Design Examples by Alan 
Williams, Third Edition, 2007, International Code Council.

80. Design Assistant is a Microsoft Excel spreadsheet that can be used to facilitate creation of spColumn text 
import files for a variety of sections including dumbbell shaped and C-shaped shear walls.
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• Choose Example 4 Tab in the spreadsheet. 

• Input the data shown below: 

- Under OVERALL SECTION WIDTH IN X, input 15. 

- Under OVERALL SECTION HEIGHT IN Y, input 144. 

- Under WEB WIDTH, input 12. 

- Under WEB HEIGHT, input 114. 

- Under NUMBER OF BOUNDARY BARS IN X, input 3. 

- Under NUMBER OF BOUNDARY BARS IN Y, input 3. 

- Under NUMBER OF WEB BARS PER LAYER, input 8. 

- Under WEB BAR SPACING, input 18. 

- Under COVER, input 2.5. 

- Under REINFORCEMENT AREA PER BOUNDARY BAR, input 0.79. 

- Under REINFORCEMENT AREA PER WEB BAR, input 0.31.
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• Press Export Geometry Button and Save Geometry File box appears. Save the file as 
Example4-Geo.txt

• Press Export Reinforcement button and Save Reinforcement File dialog box appears. 
Save the file as Example4-Reinf.txt

• Save and close the Design Assistant spreadsheet.
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• From the Start Menu, go to All Programs | StructurePoint | spColumn and run 
spColumn

• From the File menu, choose New. Any input data is cleared and the default values are 
restored. 

• From the File menu, choose Import | Import Data. Import Data (from text file) dialog 
box appears. Make sure that Geometry radio button is checked, choose OK

• Open Import File box appears. Select Example4-Geo.txt file and choose Open. The 
shear wall geometry appears on the spColumn screen.

• From the File menu, choose Import | Import Data. Import Data (from text file) box 
appears. Press Reinforcement radio button, then Choose OK 
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• Open Import File box appears. Select Example4-Reinf.txt file and choose Open. 
The shear wall reinforcement appears on the spColumn screen as well.

• From the Input menu, choose General Information Tab. Input Project Information and 
leave all other options in their default settings of ACI 318-14 design code. Choose OK
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5.4.2 Assigning Properties

• From the Input menu, choose the Material Properties tab. VERIFY CONCRETE STRENGTH, 
fc’, and REINFORCING STEEL STRENGTH, fy, values are entered as 4 ksi, and 60 ksi 
respectively. Leave all other options in their default settings. Choose OK 

• From the Input menu, choose Reinforcement | Confinement Tab. 

- From the CONFINEMENT drop-down menu choose OTHER. 

- Input AXIAL COMPRESSION (a) as 0.85.

- Input COMPRESSION CONTROLLED FAILURE (c) as 0.7. 

- Leave all other options in their default settings. Choose OK
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• From the Input menu, choose Loads | Axial Loads Tab

- Input 649.5 for the INITIAL LOAD. The initial
axial load was selected through trial and error
procedure in order to match neutral axis depth of 24
in. given in the example.

- Choose INSERT. Then, choose OK

5.4.3 Solving

• From the Solve menu, choose Execute. 

- Click NO when the warning message is displayed saying “Reinforcement ratio is less
than 1%. Consider column as architectural (i.e. fc is reduced by reinforcement
ratio?)”.

- The solver of the program is started and, upon completion, displays the interaction
diagram of the section. 

5.4.4 Viewing and Printing Results

• From the View menu, choose Results. 

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

• From the File menu, choose Print Report | Default Report. 

- Select the printer to send the default report to.

- Choose PRINT.
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2.1. Concrete

2.2. Steel

3.1. Shape and Properties
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3.2. Section Figure

3.3. Exterior Points

4.1. Bar Set: ASTM A615

4.2. Confinement and Factors
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4.3. Arrangement

4.4. Bars Provided
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5.5 Example 5 - Capacity of an Irregular Section

5.5.1 Problem Formulation

Compute horizontal moment capacity Mx of the unsymmetrical beam cross section81 shown 
below. Use 3-ksi concrete and 60-ksi reinforcing steel.

Note: when instructed to move to a location (15, 25), move the cursor until the cells in the Status 
bar show “x=15” and “y=25”.

From the File menu, choose New. Any input data is cleared and the default values are restored. 

81. Based on Example 4.7, pp 161 from Reinforced Concrete: Mechanics and Design by James G. Wight and 
James K. MacGregor, Fifth Edition, 2009, Pearson Prentice Hall, Pearson Education Inc.
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24 "
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5.5.2 Preparing Input

• From the Input menu, choose General Information.

- Select English units and ACI 318-14 code. 

- Select BIAXIAL for RUN AXIS, Investigation for run
option and NO for CONSIDER SLENDERNESS.

- Choose OK. 

5.5.3 Assigning Properties

• From the Input menu, choose Material Properties. 

- Under CONCRETE, input 3 for the STRENGTH. Other
properties are computed and will be accepted.

- Choose OK.

• From the Input menu, choose Section | Irregular. When spSection module is loaded its 
window occupies the desktop. Open the DRAWING AREA box by selecting the arrow under 

the Grid On/Off button .

- Under Limits, input 0 and 24 for the MINIMUM X and MAXIMUM X, respectively. 

- Under limits, input -20 and 4 for the MINIMUM Y and MAXIMUM Y, respectively. 

- Under GRID, input 4 and 4 for X and Y grid STEP, respectively.

- Choose OK.

• Click Polygon icon under Draw Menu. The default shape type is Solid.
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- In the drawing area, move the cursor to the location (0, 0) and click the left mouse
button. A node is inserted.

- Move to (12, 0) and click the left mouse button.

- Move to (12, -20) and click the left mouse button.

- Move to (24, -20) and click the left mouse button.

- Move to (24, 4) and click the left mouse button.

- Move to (0, 4) and click the left mouse button.

- Move to (0, 0) and click the left mouse button.

• Select Single icon under Reinforcement Menu. 

- Under Options Menu on the left, select #9 from the drop-down list for BAR SIZE.
Under Commands Menu, enter 14.142 for X-COORD and -17.5 for Y-COORD.
Choose OK.

- Under Options Menu on the left, select #8 from the drop-down list for BAR SIZE.
Under Commands Menu, enter 18.0 for X-COORD and -17.5 for Y-COORD. Choose
OK.

- Under Options Menu on the left, select #8 from the drop-down list for BAR SIZE.
Under Commands Menu, enter 22.0 for X-COORD and -17.5 for Y-COORD. Choose
OK.

• From the General Menu, choose Save and Exit. You are returned to spColumn and the 
section is shown in the Information bar.
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• From the Input menu, choose Input | 
Loads | Factored

- Enter LOAD as 0 (zero), X-MOMENT as -225 k-ft
and Y-MOMENT as 0. Choose INSERT.

- Choose OK.

5.5.4 Solving

• From the Solve menu, choose Execute. 

- A message is displayed saying “Reinforcement
ratio is less than 1% Consider column as
architectural (i.e. fc is reduced by reinforcement
ratio?)”. Click NO for this option.

- The solver of the program is started and, upon completion, displays the interaction
diagram of the section. 

5.5.5 Viewing and Printing Results

• From the View menu, choose Results. 

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

• From the File menu, choose Print Report | Default Report. 

- Select the printer to send the default report to.

- Choose PRINT.

• From the File menu, choose Print Screen. 

- Select the printer to send the graphical results to.

- Choose PRINT

- Change the interaction diagram to show the P-M diagram at 180o using the  icon.
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2.1. Concrete

2.2. Steel

3.1. Shape and Properties
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3.2. Section Figure

3.3. Exterior Points

4.1. Bar Set: ASTM A615

4.2. Confinement and Factors

4.3. Arrangement
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4.4. Bars Provided
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5.6 Example 6 - Investigation of a Rectangle Short 
Column

5.6.1 Problem Formulation

Determine the adequacy of a 200 mm x 350 mm column82 with 6-15M bars. Note that since the 
least column dimension is less than 300mm, the maximum section axial design capacity is capped 
in CSA A23.3-14 as required by clause 10.10.4.

The concrete used is 30 MPa and the reinforcing steel is 400 MPa.

The factored load values for the column under consideration are as follows:

From the File menu, choose New. Any input data is cleared and the 
default values are restored. 

5.6.2 Preparing Input

• From the Input menu, choose General Information.

- Input the PROJECT header. 

- Select METRIC units and CSA A23.3-14 code. 

- Select About X-Axis for run axis, Investigation for run
option and No for Consider Slenderness?

- Choose OK.

5.6.3 Assigning Properties

• From the Input menu, choose Material Properties.

82. Based on STRUCTUREPOINT Hand Verification Example based on CSA A23.3-14 Concrete Design 
Handbook

P (kN) 500 kN

Mux (kN-m) 37.5 kN-m
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- Input 30 for the CONCRETE STRENGTH, and 400 for the REINFORCING STEEL

STRENGTH. Other properties are computed and will be accepted. 

- Choose OK.

• From the Input menu, choose Section | Rectangular. 

- Input 350 and 200 for the section width (along X) and depth (along Y). 

- Choose OK.

• From the Options menu, choose Reinforcement.

- For Bar Set, choose CSA G30.18 from the drop down list.

- Choose OK.

• From the Input menu, choose Reinforcement | Sides Different

- Input 3-#15 bars for TOP and BOTTOM and 0-#15 for LEFT and RIGHT. Input 50 in
for the cover and select LONGITUDINAL BARS. 

- Choose OK. 

• From the Input menu, choose Loads | Factored. 

- Input 500 for the AXIAL LOAD, 37.5 for the X-MOMENTS. 

- Choose INSERT to add the entry to the list box. 

- Choose OK.
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5.6.4 Solving

• From the Solve menu, choose Execute. 

- The solver of the program is started and, upon completion, displays the interaction
diagram of the section with the load point plotted within the diagram. 

5.6.5 Viewing and Printing Results

• From the View menu, choose Results. 

- Use the explorer in the spResults module or the Previous Table and Next Table
buttons in the toolbar to navigate through the tables.

- Use the close button at the top right corner of the spResults windows to quit the
spResults module and get back to spColumn.

• From the File menu, choose Print Report | Default Report. 

- Select the printer to send the default report to.

- Choose PRINT.

• From the File menu, choose Print Screen. 

- Select the printer to send the graphical results to.

- Choose PRINT.
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2.1. Concrete

2.2. Steel

3.1. Shape and Properties
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3.2. Section Figure

4.1. Bar Set: CSA G30.18

4.2. Confinement and Factors

4.3. Arrangement
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4.4. Bars Provided
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6.1 Introduction

spSection is an add-on module to the spColumn program. It enables the user to investigate
irregularly shaped reinforced concrete sections subject to a combination of loadings. spSection
considers a polygonal section reinforced with bars located at any location. The section may
contain one opening. 

spSection is accessed from within spColumn. Once spColumn is started, you can activate
spSection by selecting the Section | Irregular command from the Input menu. This starts
spSection, locks the spColumn window and maximizes the spSection window. The section
geometry may then be defined by drawing it on the screen or by inputting the coordinates of the
polygon nodes. Once the section definition is complete, return to spColumn by selecting Save and
Exit from the Main menu or the Toolbar. The following is a list of the spSection window
components.
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6.2 Main Menu

Import

Imports the DXF File. 

Export

Exports to the DXF File. 

Errors

Lists the errors in the spSection model. 

Validate

Checks if the section is valid for analysis by spColumn.

Save and Exit

Saves changes and exits.

Exit without Saving

Discards changes and exits.

6.3 View Menu

Toolbar

Provides five options to determine the location and size of the toolbar.

Settings

Provides the user with options to modify general and color settings. 

In General Settings, user controls are provided for display, at exit choices, and precision
options. 

Display:

• Coordinate system sign: Provides a cross-hair indicating the X and Y axes.

• Object Centroid: Provides a cross-hair at the object centroid.

• Grid labels: Show or hide grid labels

• Flying text: Displays the parameters related to the operation in flying text box while 
performing that operation.
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At Exit:

• Combine all shapes: When checked, it combines all shapes at exit.

• Align model centroid to coordinate system origin: When checked, it aligns model cen-
troid to the coordinate system centroid at exit.

Precision:

• General: Shows on 0 to 3 trailing decimal places when entering dimensions at the left 
panel textboxes.

• Flying text: Shows on 0 to 3 trailing decimal places when displaying flying text.

In Colors Settings:

• Shapes: Color options for solid, selected solids, openings, and selected openings.

• Reinforcement: Color options for bar, selected bar, and overlapped bar.

• Misc: Color options for main grid lines, other grid lines, and screen background.
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View Controls

Shows or hides the view controls. Arrows in the upper right corner provide controls for the
location or the tool and extent of functions. The icons show in blue when active. View controls
provide the following operator functions:

• Show and hide 3D rotation cube.

• Rotate section in 3D (shift + middle mouse button)

• Zoom to workspace

• Zoom to model

• Zoom to window

• Zoom in (mouse wheel)

• Zoom out (mouse wheel)

• Pan (middle mouse button)

• Grid On/Off: Shows or hides the grids. The arrow at 
the bottom of the icon opens Drawing Area dialog box 
which enables the user to edit the limits of drawing 
area and grid steps in X, and Y directions.

• Snap On/Off: Activates or deactivates the snap fea-
ture, the arrow at the bottom of the icon opens Snap 
dialog box. Snap options are: Grid, shapes, cover, rein-
forcements, intersections, and coordinate system ori-
gin.

• Ortho mode On/Off: Restrict cursor movement to horizontal and vertical direction 
when creating or modifying sections.

Status Bar

Shows or hides the status bar. Status bar is located at the bottom of the screen and displays the
bars set, active command and its instruction, the coordinates of the cursor, and the units. 
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6.4 Toolbar - General

Save and Exit

Saves changes and exits.

Exit without Saving

Discards changes and exits.

Undo

Undo last operation (Ctrl + Z).

Redo

Redo last operation (Ctrl + Y).

6.5 Toolbar - Modify

Mirror

Mirrors selected items about line or point.

Delete

Deletes selected items.

Copy

Copies selected items to new location.

Rotate

Rotates selected items from a base point by a specified angle.

Move

Moves selected items to new location.

Select

Selects items to perform operations.
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6.6 Toolbar - Draw

Rectangle

Creates rectangular shapes of solid or opening by clicking the start and end points. Alternately,
the shape can be created by typing precise start point coordinates and dimensions at the left
panel when Draw | Rectangle icon is active.

Polygon

Creates polygon shapes by specifying its vertices in the drawing area until the closed polygon
shape is obtained or by typing precise point coordinates and then pressing close button at the
left panel when Draw | Polygon icon is active.

Circle

Creates circular shapes in one of the three methods namely;

• Circle | Draw circle by radius: Create circular shape by specifying center point and 
radius.

• Circle 2 points | Draw circle by diameter: Create circular shape by specifying its diam-
eter.

• Circle 3 points | Draw circle by tangent points: Create circular shape by specifying 
three tangent points.

Combine

Combines all shapes or just selected shapes.

6.7 Toolbar - Reinforcement

Single – Add single reinforcement bar 

Creates a single reinforcement bar at a point. When the reinforcement single icon is active, sin-
gle bar can be created by clicking at any point on the screen. Alternatively, single reinforce-
ment bar can also be created by entering precise coordinates at the left panel. 

Linear – Add bars in linear pattern 

Creates a linear bar pattern based on the specified bar number or bar spacing. When the rein-
forcement linear icon is active, linear bar pattern can be created by specifying start and next
points on the screen. Alternatively, linear bar pattern can also be created by entering precise
coordinates of the start point and next points at the left panel. 
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Rectangular – Add bars in rectangular pattern 

Creates a rectangular bar pattern based on the specified number of bars in the X and Y direc-
tions respectively. When the reinforcement rectangular icon is active, rectangular bar pattern
can be created by specifying start and end points of the diagonal on the screen. Alternatively,
rectangular bar pattern can also be created by entering precise coordinates of the start point
and the translation vector of the diagonal for the rectangle, at the left panel. 

Circular – Add bars in circular pattern 

Creates a circular bar pattern based on the specified bar number or bar spacing. When the rein-
forcement circular icon is active, circular bar pattern can be created by specifying the center
point of the circle and the end point of its radius on the screen. Alternatively, circular bar pat-
tern can also be created by entering precise coordinates of the center point, the radius and its
angle with x-axis, at the left panel. 

Cover

Shows and hides the bar cover guide. The cover type i.e. clear or to bar center and the required
value can be specified while using each of the above mentioned commands for reinforcement. 

6.8 Toolbar - Reshape

Add – Add nodes 

Creates additional nodes on shape edges.

Select – Select nodes 

Selects nodes to move or delete.

6.9 Toolbar - Misc

Measure

Measures distance between two points.

Validate

Checks if the section is valid for analysis by spColumn.
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Settings

Modifies settings for view, display, combine, precision, and colors. Refer to View Menu for
more information on settings.

6.10 Toolbar - DXF

Export DXF

Exports the model to DXF file.

Import DXF

Imports a model from DXF file.
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7.1 Introduction

spReporter is a module of the spColumn program. It enables the user to view, customize, print and
export reports in different formats. 

spReporter is accessed from within spColumn. Once a successful run has been performed, you can
open spReporter by selecting the Reporter command from the View menu. Alternatively,
spReporter can also be accessed by pressing the F7 key or by clicking on the spReporter button in
the program toolbar. Immediately after opening spReporter, you can export and/or print the default
report by pressing Export/Print button. Various options to customize the report before printing
and/or exporting it are also provided. Once the work in spReporter is complete click the close
button in the top right corner to exit the spReporter window.
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7.2 Toolbar

Previous page

Displays the previous page of the report.

Next page

Displays the next page of the report.

Page number box

Displays the page with the page number entered in the box.

Zoom in

 Zooms in on the report (Ctrl + Mouse wheel up).

Zoom out

 Zooms out on the report (Ctrl + Mouse wheel down).

Zoom box

Zooms on the report preview to the extent typed in the box or selected from the dropdown 
list.

Fit to window width and enable scrolling

Fits the width of report to the preview space width and enables scrolling.

Fit one full page to window

Fits one full page in the preview space.

Pan

When toggled on and if the report is bigger than preview window, enables panning the 
report.

 Text selection

When toggled on enables selecting text in the report.

Settings

Modifies settings for report and explorer panel.
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– Report Settings

Regenerate automatically: Enables automatic regeneration of report when content 
selection is modified by the user.

Split long tables: Displays table headings in all pages when tables are split along 
several pages.

– Explorer Settings

Location: Displays explorer panel on the left or right side of screen depending on 
selection.

Hide inactive items:: Hides unused tables from the explorer view.

Explorer

Shows or hides the explorer panel.

7.3 Export / Print Panel

Export

Exports the report in the selected format.

Print

Prints the report in the selected format when the option is available.
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Type

Provides 5 format options to print and/or export the reports

– Word: Produces a Microsoft Word file with .docx extension.

– PDF: Produces an Adobe Acrobat file with .pdf extension.

– Text: Produces a Text file with .txt extension.

– Excel: Produces a Microsoft Excel file with .xlsx extension.

– CSV: Produces a Comma Separated file with .csv extension.

Printer

Provides the option to select available printers and change printer properties.

Settings

Provides the options to modify print settings.

– Paper: Provides the options to select from available paper sizes.

– Orientation: Provides the options to select between landscape or portrait paper orien-
tation.

– Margins: Provides the options to use narrow, normal, wide or custom margins to the 
report.

– Print range: Provides the options to select the pages to print and/or export.

7.4 Explorer panel

The explorer panel consists of all the available report items classified into sections and arranged
hierarchically. Each item listed in the explorer panel is preceded by a checkbox. The user can
check/uncheck the checkbox to include or exclude from the report, the items or sections.
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Expand all

Expands item list.

Collapse all

Collapses item list.
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8.1 Introduction

spResults is a module of the spColumn program. It enables the user to view program input and
output in tables and export them in different formats.

spResults is accessed from within spColumn. Once a model has been successfully executed, you
can open spResults by selecting the Results command from the View menu. Alternatively,
spResults can also be accessed by pressing the F6 key or by clicking on the spResults button in the
program toolbar. Once the work in spResults is complete click the close button in the top right
corner to exit spResults window.

8.2 Toolbar

Previous table

Displays the previous table.

Next table

Displays the next table.
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Table number box

Displays the table with the table number entered in the box.

Auto fit column width to view area

When toggled on always fits the width of table to the preview space width.

Maintain maximum column width

Switches all table columns to their default maximum width.

Export current table

Exports the table being viewed in the selected format.

Settings

Modifies settings for tables and explorer panel.

– Tables settings

Highlight critical items: Enables highlighting of critical items in the “Loads and 
Capacities” table.

Highlighting color: Provides color options for highlighting critical items.

– Explorer settings

Location: Displays explorer panel on the left or right side of screen depending on 
selection

Hide inactive items: Hides unused tables from the explorer view.

Explorer

Shows or hides the explorer panel.
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8.3 Explorer panel

The explorer panel consists of all the available items of the result classified into sections 
and arranged hierarchically. Any item in the explorer panel can be clicked on to display 
the corresponding table in the preview space.

Expand all

Expands item list.

Collapse all

Collapses item list.
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A.1 Import File Formats

Geometry, reinforcement or load data may be imported from a text file. The import file must be 
saved in pure ASCII (text) format. Data fields on each line should be separated by spaces or TABs. 
Comments or blank lines should not be placed within the import file. 

A.1.1 Service Loads Data:

No_Of_Load_Points

P1_D M1x_DT M1x_DB M1y_DB M1y_DB

P1_L M1x_LT M1x_LB M1y_LT M1y_LB

P1_W M1x_WT M1x_WB M1y_WT M1y_WB

P1_EQ M1x_EQT M1x_EQB M1y_EQT M1y_EQB

P1_S M1x_ST M1x_SB M1y_ST M1y_SB

...

Pn_D Mnx_DT Mnx_DB Mny_DB Mny_DB

Pn_L Mnx_LT Mnx_LB Mny_LT Mny_LB

Pn_W Mnx_WT Mnx_WB Mny_WT Mny_WB

Pn_EQ Mnx_EQT Mnx_EQB Mny_EQT Mny_EQB

Pn_S Mnx_ST Mnx_SB Mny_ST Mny_SB

Each service load point has five lines of data (one line for each load case, i.e. Dead, Live, Wind, 
Earthquake, and Snow). Each data line has five values. For a service load point i, Pi_D, 
Mix_DT, Mix_DB, Miy_DT, and Miy_DB are the axial load, Mx at top, Mx at bottom, My at top 

and My at bottom, respectively. The notation D, L, W, EQ, and S designate the Dead, Live, 

Wind, Earthquake, and Snow load cases, respectively.

A.1.2 Factored Loads Data:

No_Of_Load_Points

P1 M1x M1y

P2 M2x M2y
...
Pn Mnx Mny
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For a factored load point i, Pi is the factored axial load, Mix is the factored moment about x and 
Miy is the factored moment about y.

A.1.3 Reinforcement Data:

No_Of_Bars
A1 X1 Y1
...

An Xn Yn

For a bar i, Ai is the bar area, Xi is its x-coordinate, and Yi is its y-coordinate.

A.1.4 Geometry Data:

No_Of_Section_Nodes

Xs1 Ys1

Xs2 Ys2

...

Xsn Ysn

No_Of_Opening_Nodes

Xo1 Yo1

Xo2 Yo2

...

Xon Yon

For a section node si, Xsi is the x-coordinate of the node and Ysi is its y-coordinate.

For an opening node oi, Xoi is the x-coordinate of the node and Yoi is its y-coordinate.

If the section does not contain an opening, you must have a zero for the value of 
No_Of_Opening_Nodes.



APPENDIX

| 176 |

A.2 spColumn Text Input (CTI) file format

spColumn is able to read and save its input data into two file formats, COL file or CTI file. CTI 
files are plain text files that can be edited by any text editing software.

Caution must be used when editing a CTI file because some values may be interrelated. If one of 
these values is changed, then other interrelated values should be changed accordingly. While this 
is done automatically when a model is edited in the spColumn user graphic user interface (GUI), 
one must update all the related values in a CTI file manually in order to obtain correct results. For 
example, if units are changed from English to Metric in GUI, all the related input values are 
updated automatically. If this is done by editing a CTI file, however, not only the unit flag but also 
all the related input values must be updated manually.

The best way to create a CTI file is by using the spColumn GUI and selecting CTI file type in the 
Save As menu command. Then, any necessary modifications to the CTI file can be applied with 
any text editor. However, it is recommended that users always verify modified CTI files by 
loading them in the spColumn GUI to ensure that the modifications are correct before running 
manually revised CTI files in batch mode.

The CTI file is organized by sections. Each section contains a title in square brackets, followed by 
values required by the section. The CTI file contains the following sections.

[spColumn Version]

[Project]

[Column ID]

[Engineer]

[Investigation Run Flag]

[Design Run Flag]
[Slenderness Flag]

[User Options]
[Irregular Options]
[Ties]

[Investigation Reinforcement]
[Design Reinforcement]
[Investigation Section Dimensions]

[Design Section Dimensions]
[Material Properties]

[Reduction Factors]

[Design Criteria]
[External Points]
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[Internal Points]
[Reinforcement Bars]

[Factored Loads]
[Slenderness: Column]
[Slenderness: Column Above And Below]

[Slenderness: Beams]
[EI]

[SldOptFact]
[Phi_Delta]
[Cracked I]

[Service Loads]
[Load Combinations]

[BarGroupType]

[User Defined Bars]

[Sustained Load Factors]

Each section of a CTI file and allowable values of each parameter are described in details below. 
Corresponding GUI commands are presented in parenthesis.

#spColumn Text Input (CTI) File

The number sign, #, at the beginning of a line of text indicates that the line of text is a comment. 
The # sign must be located at the beginning of a line. Comments may be added anywhere 
necessary in a CTI file to make the file more readable. If a comment appears in multiple lines, 
each line must be started with a # sign

[spColumn Version]

Reserved. Do not edit.

[Project]

There is one line of text in this section. 

Project name (menu Input | General Information…)

[Column ID]
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There is one line of text in this section. 

Column ID (menu Input | General Information…)

[Engineer]

There is one line of text in this section. 

Engineer name (Menu Input | General Information…)

[Investigation Run Flag]

Reserved. Do not edit.

[Design Run Flag]

Reserved. Do not edit.

[Slenderness Flag]

Reserved. Do not edit.

[User Options]

There are 26 values separated by commas in one line in this section. These values are described 
below in the order they appear from left to right.

1. 0-Investigation Mode; 1-Design Mode; (Run Option on menu Input | General 
Information…)

2. 0-English Unit; 1-Metric Units; (Units on menu Input | General Information…)

3. 0-ACI 318-02; 1- CSA A23.3-94; 2-ACI 318-05; 3-CSA A23.3-04; 4-ACI 318-08; 5-ACI 
318-11; 6-ACI 318-14; 7-CSA A23.3-14 (Design Code on menu Input | General 
Information…)

4. 0-X Axis Run; 1-Y Axis Run; 2-Biaxial Run; (Run Axis on menu Input | General 
Information…)

5. Reserved. Do not edit.

6. 0-Slenderness is not considered; 1-Slenderness in considered; (Consider slenderness? on 
menu Input | General Information…)
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7. 0-Design for minimum number of bars; 1-Design for minimum area of reinforcement; 
(Bar selection on menu Input | Reinforcement | Design Criteria…)

8. Reserved. Do not edit.

9. 0-Rectangular Column Section; 1-Circular Column Section; 2-Irregular Column Section; 
(menu Input | Section)

10. 0-Rectangular reinforcing bar layout; 1-Circular reinforcing bar layout; (Bar Layout on 
menu Input | Reinforcement | All Sides Equal)

11. 0-Structural Column Section; 1-Architectural Column Section; 2-User Defined Column 
Section; (Column Type on menu Input | Reinforcement | Design Criteria…)

12. 0-Tied Confinement; 1-Spiral Confinement; 2-Other Confinement; (Confinement drop-
down list on menu Input | Reinforcement | Confinement…)

13. Load type for investigation mode: (menu Input | Loads) 0-Factored; 1-Service; 2-Control 
Points; 3-Axial Loads

14. Load type for design mode: (menu Input | Loads)

0-Factored; 1-Service; 2-Control Points; 3-Axial Loads

15. Reinforcement layout for investigation mode: (menu Input | Reinforcement)

0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern

16. Reinforcement layout for design mode: (menu Input | Reinforcement)

0-All Side Equal; 1-Equal Spacing; 2-Sides Different; 3-Irregular Pattern

17. Reserved. Do not edit.

18. Number of factored loads (menu Input | Loads | Factored…)

19. Number of service loads (menu Input | Loads | Service…)

20. Number of points on exterior column section 

21. Number of points on interior section opening

22. Reserved. Do not edit.

23. Reserved. Do not edit.

24. Cover type for investigation mode: (menu Input | Reinforcement)

0-To transverse bar; 1-To longitudinal bar

25. Cover type for design mode: (menu Input | Reinforcement)

0-To transverse bar; 1-To longitudinal bar

26. Number of load combinations; (menu Input | Load | Load Combinations…)

[Irregular Options]
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There are 13 values separated by commas in one line in this section. These values are described 
below in the order they appear from left to right. (menu Input | Section | Irregular | Section Editor 
menu Main | Drawing Area)

1. Reserved. Do not edit.

2. Reserved. Do not edit.

3. Reserved. Do not edit.

4. Reserved. Do not edit.

5. Area of reinforcing bar that is to be added through irregular section editor

6. Maximum X value of drawing area of irregular section editor

7. Maximum Y value of drawing area of irregular section editor

8. Minimum X value of drawing area of irregular section editor

9. Minimum Y value of drawing area of irregular section editor

10. Grid step in X of irregular section editor

11. Grid step in Y of irregular section editor

12. Grid snap step in X of irregular section editor

13. Grid snap step in Y of irregular section editor

[Ties]

There are 3 values separated by commas in one line in this section. These values are described 
below in the order they appear from left to right. (Menu Input | Reinforcement | Confinement…)

1. Index (0 based) of tie bars for longitudinal bars smaller that the one specified in the 3rd 
item in this section in the drop-down list

2. Index (0 based) of tie bars for longitudinal bars bigger that the one specified in the 3rd item 
in this section in the drop-down list

3. Index (0 based) of longitudinal bar in the drop-down list

[Investigation Reinforcement]

This section applies to investigation mode only. There are 12 values separated by commas in one 
line in this section. These values are described below in the order they appear from left to right.

If Side Different (Menu Input | Reinforcement | Side Different…) is selected:

1. Number of top bars
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2. Number of bottom bars

3. Number of left bars

4. Number of right bars

5. Index (0 based) of top bars (Top Bar Size drop-download list)

6. Index (0 based) of bottom bars (Bottom Bar Size drop-download list)

7. Index (0 based) of left bars (Left Bar Size drop-download list)

8. Index (0 based) of right bars (Right Bar Size drop-download list)

9. Clear cover to top bars

10. Clear cover to bottom bars

11. Clear cover to left bars

12. Clear cover to right bars

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal…) or Equal Spacing (Menu 
Input | Reinforcement | Equal Spacing…) is selected:

1. Number of bars (No. of Bars text box)

2. Reserved. Do not edit.

3. Reserved. Do not edit.

4. Reserved. Do not edit.

5. Index (0 based) of bar (Bar Size drop-down list)

6. Reserved. Do not edit.

7. Reserved. Do not edit.

8. Reserved. Do not edit.

9. Clear cover to bar (Clear Cover text box)

10. Reserved. Do not edit.

11. Reserved. Do not edit.

12. Reserved. Do not edit.

If Irregular Pattern (Menu Input | Reinforcement | Irregular Pattern…) is selected:

Reserved. Do not edit.

[Design Reinforcement]

This section applies to design mode only. There are 12 values separated by commas in one line in 
this section. These values are described below in the order they appear from left to right.
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If Side Different (Menu Input | Reinforcement | Side Different…) is selected:

1. Minimum number of top and bottom bars

2. Maximum number of top and bottom bars

3. Minimum number of left and right bars

4. Maximum number of left and right bars

5. Index (0 based) of minimum size for top and bottom bars

6. Index (0 based) of maximum size for top and bottom bars

7. Index (0 based) of minimum size for left and right bars

8. Index (0 based) of maximum size for left and right bars

9. Clear cover to top and bottom bars

10. Reserved. Do not edit.

11. Clear cover to left and right bars

12. Reserved. Do not edit.

If All Sides Equal (Menu Input | Reinforcement | All Sides Equal…) or Equal Spacing (Menu 
Input | Reinforcement | Equal Spacing…) is selected:

1. Minimum number of bars

2. Maximum number of bars

3. Reserved. Do not edit.

4. Reserved. Do not edit.

5. Index (0 based) of minimum size of bars

6. Index (0 based) of maximum size of bars

7. Reserved. Do not edit.

8. Reserved. Do not edit.

9. Clear cover

10. Reserved. Do not edit.

11. Reserved. Do not edit.

12. Reserved. Do not edit.

[Investigation Section Dimensions]

This section applies to investigation mode only. There are 2 values separated by commas in one 
line in this section. These values are described below in the order they appear from left to right.
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If rectangular section (Menu Input | Section | Rectangular…) is selected:

1. Section width (along X)

2. Section depth (along Y)

If circular section (Menu Input | Section | Circular…) is selected:

1. Section diameter

2. Reserved. Do not edit.

If irregular section (Menu Input | Section | Irregular) is selected:

1. Reserved. Do not edit.

2. Reserved. Do not edit.

[Design Section Dimensions]

This section applies to design mode only. There are 6 values separated by commas in one line in 
this section. These values are described below in the order they appear from left to right.

If rectangular section (Menu Input | Section | Rectangular…) is selected:

1. Section width (along X) Start

2. Section depth (along Y) Start

3. Section width (along X) End

4. Section depth (along Y) End

5. Section width (along X) Increment

6. Section depth (along Y) Increment

If circular section (Menu Input | Section | Circular…) is selected:

1. Diameter start

2. Reserved. Do not change.

3. Diameter end

4. Reserved. Do not change.

5. Diameter increment

6. Reserved. Do not change.

[Material Properties]
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There are 11 values separated by commas in one line in this section. These values are described 
below in the order they appear from left to right. (Menu Input | Material Properties…)

1. Concrete strength, f’c

2. Concrete modulus of elasticity, Ec

3. Concrete maximum stress, fc

4. Beta(1) for concrete stress block

5. Concrete ultimate strain

6. Steel yield strength, fy

7. Steel modulus of elasticity, Es

8. Precast material for concrete. Only applicable for CSA A23.3-14 and CSA A23.3-04.

0-Non-precast; 1-Precast

9. Standard material for concrete

0-Non-standard; 1-Standard

10. Standard material for reinforcing steel

0-Non-standard; 1-Standard

11. Compression-controlled strain limit

[Reduction Factors]

There are 5 values separated by commas in one line in this section. These values are described 
below in the order they appear from left to right. (Menu Input | Reinforcement | Confinement…)

1. Phi(a) for axial compression

2. Phi(b) for tension-controlled failure

3. Phi(c) for compression-controlled failure

4. Reserved. Do not edit

5. Minimum dimension of tied irregular sections for CSA-A23.3-14; 0-for all other cases

[Design Criteria]

There are 4 values separated by commas in one line in this section. These values are described 
below in the order they appear from left to right. (Menu Input | Reinforcement | Design Criteria…)

1. Minimum reinforcement ratio

2. Maximum reinforcement ratio
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3. Minimum clear spacing between bars

4. Design/Required ratio

[External Points]

This section applies to irregular section in investigation mode only. The first line contains the 
number of points on exterior section perimeter. Each of the following lines contains 2 values: X 
and Y coordinates (separated by comma) of a point.

Number of Points, n
Point_1_X, Point_1_Y

Point_2_X, Point_2_Y
...

Point_n_X, Point_n_Y

[Internal Points]

This section applies to irregular section in investigation mode only. The first line contains the 
number of points on an interior opening perimeter. Each of the following lines contains 2 values: 
X and Y coordinates (separated by comma) of a point. If no opening exists, then the first line must 
be 0.

Number of Points, n

Point_1_X, Point_1_Y

Point_2_X, Point_2_Y

...

Point_n_X, Point_n_Y

[Reinforcement Bars]

This section applies to irregular section in investigation mode only. The first line contains the 
number of reinforcing bars. Each of the following lines contains 3 values: area, X and Y 
coordinates (separated by comma) of a bar. 

Number of bars, n

Bar_1_area, Bar_1_X, Bar_1_Y
Bar_2_area, Bar_2_X, Bar_2_Y
...

Bar_n_area, Bar_n_X, Bar_n_Y
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[Factored Loads]

The first line contains the number of factored loads defined. Each of the following lines contains 
3 values: axial load, X-moment, and Y-moment separated by commas. (Menu Input | Loads | 
Factored Loads…)

Number of Factored Loads, n
Load_1, X-Moment_1, Y-Moment_1
Load_2, X-Moment_2, Y-Moment_2

...
Load_n, X-Moment_n, Y-Moment_n

[Slenderness: Column]

This section contains 2 lines describing slenderness parameters for column being designed. The 
first line is for X-axis parameters, and the second line is for Y-axis parameters.

There are 8 values1 separated by commas in each line. These values are described below in the 
order they appear from left to right. (Menu Input | Slenderness | Design Column…)

1. Column clear height

2. k(nonsway)

3. k(sway)

4. 0-Sway frame; 1-Nonsway frame

5. 0-Compute ‘k’ factors; 1-Input k factors

6. Pc)/Pc

7. Pu)/Pu

8. 0-Do not ignore moment magnification along column length in sway frames; 1-Ignore 
moment magnification along column length in sway frames. Use for ACI 318-11 and ACI 
318-08 only. For all other codes the value must be 0.

[Slenderness: Column Above And Below]

This section contains 2 lines describing slenderness parameters for column above and column 
below. The first line is for column above, and the second line is for column below. (Menu Input | 
Slenderness | Columns Above/Below…)

1.  Value No 8 introduced in spColumn v4.60.
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There are 6 values separated by commas in line 1 for column above. These values are described 
below in the order they appear from left to right. 

1. 0-Column specified; 1-No column specified

2. Column Height

3. Column width (along X)

4. Column depth (along Y)

5. Concrete compressive strength, f’c

6. Concrete modulus of elasticity, Ec

There are 6 values separated by commas in line 2 for column below. These values are described 
below in the order they appear from left to right.

1. 0-Column specified; 1-No column specified

2. Column Height

3. Column width (along X)

4. Column depth (along Y)

5. Concrete compressive strength, f’c

6. Concrete modulus of elasticity, Ec

[Slenderness: Beams]

This section contains 8 lines. Each line describes a beam. 

Line 1: X-Beam (perpendicular to X), Above Left

Line 2: X-Beam (perpendicular to X), Above Right

Line 3: X-Beam (perpendicular to X), Below Left

Line 4: X-Beam (perpendicular to X), Below Right

Line 5: Y-Beam (perpendicular to Y), Above Left

Line 6: Y-Beam (perpendicular to Y), Above Right

Line 7: Y-Beam (perpendicular to Y), Below Left

Line 8: Y-Beam (perpendicular to Y), Below Right

There are 7 values separated by commas for each beam in each line. (Menu Input | Slenderness | 
X-Beams…, Input | Slenderness | Y-Beams…) These values are described below in the order they 
appear from left to right.
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1. 0-beam specified; 1-no beam specified

2. Beam span length (c/c)

3. Beam width

4. Beam depth

5. Beam section moment of inertia

6. Concrete compressive strength, f’c

7. Concrete modulus of elasticity, Ec

[EI]

Reserved. Do not edit.

[SldOptFact]

There is 1 value in this section for slenderness factors. (Code Default and User Defined radio 
buttons on menu Input | Slenderness | factors…)

0-Code default; 1-User defined

[Phi_Delta]

There is 1 value in this section for slenderness factors. (Menu Input | Slenderness | factors…)

Stiffness reduction factor

[Cracked I]

There are 2 values separated by commas in one line in this section. These values are described 
below in the order they appear from left to right. (Menu Input | Slenderness | factors...)

1. Beam cracked section coefficient

2. Column cracked section coefficient

[Service Loads]

This section describes defined service loads. (Menu Input | Loads | Service…) The first line 
contains the number of service loads. Each of the following lines contains values for one service 
load.
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There are 25 values for each service load in one Line separated by commas. These values are 
described below in the order they appear from left to right.

1. Dead Axial Load

2. Dead X-moment at top

3. Dead X-moment at bottom

4. Dead Y-moment at top

5. Dead Y-moment at bottom

6. Live Axial Load

7. Live X-moment at top

8. Live X-moment at bottom

9. Live Y-moment at top

10. Live Y-moment at bottom

11. Wind Axial Load

12. Wind X-moment at top

13. Wind X-moment at bottom

14. Wind Y-moment at top

15. Wind Y-moment at bottom

16. EQ. Axial Load

17. EQ. X-moment at top

18. EQ. X-moment at bottom

19. EQ. Y-moment at top

20. EQ. Y-moment at bottom

21. Snow Axial Load

22. Snow X-moment at top

23. Snow X-moment at bottom

24. Snow Y-moment at top

25. Snow Y-moment at bottom

[Load Combinations]

This section describes defined load combinations. (Menu Input | Loads | Load Combinations…) 
The first line contains the number of load combinations. Each of the following lines contains load 
factors for one load combination.
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Number of load combinations, n
Dead_1, Live_1, Wind_1, E.Q._1, Snow_1

Dead_2, Live_2, Wind_2, E.Q._2, Snow_2
...
Dead_n, Live_n, Wind_n, E.Q._n, Snow_n

[BarGroupType]

There is 1 value in this section. (Bar Set drop-down list on menu Options | Reinforcement…)

0-User defined

1-ASTM615

2-CSA G30.18

3-prEN 10080

4-ASTM615M

[User Defined Bars]

This section contains user-defined reinforcing bars. (Menu Options | Reinforcement…) The first 
line contains the number of defined bars. Each of the following lines contains values for one bar 
separated by commas.

Number of user-defined bars, n

Bar_1_size, Bar_1_diameter, Bar_1_area, Bar_1_weight

Bar_2_size, Bar_2_diameter, Bar_2_area, Bar_2_weight
...

Bar_n_size, Bar_n_diameter, Bar_n_area, Bar_n_weight

[Sustained Load Factors]

There are 5 values separated by commas in one line in this section. Each value respectively 
represents percentage of Dead, Live, Wind, EQ, and Snow load case that is considered sustained 
(Menu Input | Loads | Service…).
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A.3 Conversion Factors - English to SI

To convert from To Multiply by

in. m (1000 mm) 0.025400

ft m 0.304800

lb N (0.001 kN) 4.448222

kip (1000 lbs) kN 4.448222

plf (lb/ft) N/m 14.593904

psi (lb/in.2) kPa 6.894757

ksi (kips/in.2) MPa 6.894757

psf (lb/ft2) N/m2
 (Pa) 47.88026

pcf (lb/ft3) kg/m3
 16.018460

ft-kips kN • m 1.355818
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A.4 Conversion Factors - SI to English

To convert from To Multiply by 

m (1000 mm) in 39.37008 

m ft 3.28084 

N (0.001 kN) lb 0.224809 

kN kip (1000 lbs) 0.224809 

kN/m plf (lb/ft) 68.52601 

MPa psi (lb/in2) 145.0377 

MPa ksi (kips/in2) 0.145038 

kN/m2
 (kPa) psf (lb/ft2) 20.88555 

kg/m3
 pcf (lb/ft3) 0.062428 

kN • m ft-kips 0.737562 
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A.5 Material Strength Value Limits

ACI
Standard Material Non-Standard Material

Min. Max. Min. Max.
f'c 2 ksi 12 ksi 2 ksi 20 ksi
fy 10 ksi 80 ksi 10 ksi 270 ksi

CSA
Standard Material Non-Standard Material

Min. Max. Min. Max.
f'c 10 MPa 80 MPa 10 MPa 150 MPa
fy 100 MPa 500 MPa 100 MPa 1860 MPa
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A.6 Contact Information

Web Site: http://www.StructurePoint.org

E-mail: 
info@StructurePoint.org

 
support@StructurePoint.org

 
StructurePoint, LLC. 
5420 Old Orchard Road 
Skokie, IL 60077 
USA 

Phone: (847) 966-4357 
Fax: (847) 966-1542 

https://www.structurepoint.org/
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